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Section 1: SEER*Abs Installation

The registry’s first installation of SEER*Abs should be on the workstation of the registry’s
SEER*Abs system administrator. The system administrator will configure SEER*Abs and create a
registry-specific installation program for you and other SEER*Abs users at the registry.

To install SEER*Abs on your computer:

1. The SEER*Abs software requires Java 1.6.0 or later. Follow these steps to determine the
version of Java installed on your computer:

a. Enter java -version at a DOS prompt.

b. If you do not have the required version, uninstall the existing version of Java and
install the latest version. More information related to the appropriate version of Java
is provided on the SEER*Abs Web site (seer.cancer.gov/seerdms/portal/seerabs).

2. Install SEER*Abs by executing the SEER*Abs installer provided to you by your registry’s
SEER*Abs system administrator. Please refer to the SEER*Abs Installation Guide or
documentation provided by your registry’s system administrator for further instructions.



Section 2: Introduction to SEER*Abs

Install your registry’s version of SEER*Abs on your laptop. The system configuration defines how
patient and record data are displayed in the system, the availability of reference data, your
username and initial password, and your Abstractor ID. Please contact your registry’s IT staff for
assistance with the SEER*Abs installation or to request changes to the configuration.

Logging In

Your user name and initial password were defined by your registry’s system administrator when
SEER*Abs was configured for your laptop. If a shortcut was created, the SEER*Abs icon & will be
displayed on your desktop or in your system tray.

To log in:

1.

Click the SEER*Abs icon or double-click the seerabs.exe executable file. SEER*Abs will load
configuration files and execute initialization scripts. You may continue with the login
process while SEER*Abs loads and executes the scripts.

Enter your username and password. The username field will default to the username
entered in the previous session.

If your work will be related to data for one facility, you may specify the Facility on the login
page. This sets the Current Facility for your session. The Current Facility is used as the
default facility in the worklist and, depending on your registry’s configuration; it may be
used as a default value for some data entry fields. It may also be used in scripts that
create extracts and download data from your registry database. Consult your registry’s
SEER*Abs system administrator to determine the ways in which the Current Facility is used.

a. To specify the Current Facility on the login page, enter the facility ID or use the
lookup to search for a facility. SEER*Abs Facility IDs are the same as those in your
central registry’s data management system. If your registry uses SEER*DMS, you
do not have to enter the FAC- prefix.

b. If you are not working on data for a single facility or if you have not yet downloaded
the facility list from your central registry’s database, you may leave this field blank.
(Facility lists in SEER*Abs are updated when SEER*Abs is synchronized with data
from the registry’s central database.)

4. Click Login.

5.

If this is your first SEER*Abs Session, you will be prompted to change your password:

a. Enter a value in Password. Password requirements are described below in the
Changing Your Password section of this chapter.

b. Verify the new password by re-entering it into the Repeat Password field.

c. Click OK.



Changing Your Password

SEER*Abs provides access to confidential data. It is your responsibility to protect and maintain
your password according to registry policy. Your registry may require that you periodically create a
new password. If you have forgotten your password, please contact the SEER*Abs system
administrator at your registry.

To change your password:

1. Select File > Change Password. (Keyboard alternative: use Alt-F to access the file menu
and the down arrow key to select Change Password.)

2. Enter your Current Password.

3. Enter a New Password. All passwords must be at least 8 characters in length. Security
measures to protect the confidentiality of patient data must include the use of strong
system passwords. Your password should:

a. Include symbols, digits, and letters of both upper and lower case. You must use at
least one lower case letter, one upper case letter, and one digit or punctuation mark.

b. Be significantly different from passwords that you have used in the past.
c. Not include your name, your username, your child’s name, or your pet’s name.
d. Not be a common word or name.

4. Re-enter your new password in the Repeat New Password field.

5. Click OK. Your new password will be effective immediately.

SEER*Abs Menus, Toolbar, and Shortcuts

Every item on the SEER*Abs menus can be accessed via keyboard short-cuts. In addition, items
on the Show menu can be accessed via toolbar icons. When logged on as a standard user, the
toolbar includes four items - Worklist, Editor, Search, and Synchronization. The menus and tools
for the standard user are described in this manual. The Configuration, Users, and Log tools are
only shown when logged on as the administrative user and are described in the SEER*Abs System
Administration reference.

Toolbar for Standard Users {no Admin Tools)

% SEER Abstracting Tool M=E3
File  Show  Action Help

Indicates Current Yiew



File Menu

Shortcut

Menu Item

Alt+F, arrows

New Abstract - opens a blank abstract record in the editor

Alt+F, arrows

New <other record types> — SEER*Abs can be configured to create records
other than abstract and casefinding. If your system administrator configured
SEER*ADbs to allow data entry of other record types, they will also be listed in the
File menu.

Ctrl+Shift+P

Search Patient Data - opens the Patient Data tab of the Search page. The
search filters are reset.

Ctrl+Shift+F

Search Facilities - opens the Facility tab on the Search page. The search
filters are reset.

Ctrl+Shift+Y

Search Physicians - opens the Physician tab on the Search page. The search
filters are reset.

Ctrl+Shift+D

SEER*Rx - opens the SEER*Rx drugs on the Search page.

Ctrl+Shift+I

Hematopoietic Database - opens the Hematopoietic Diseases database on the
Search page.

Alt+F, arrows

Backup Main Database - creates a backup of the data stored in the main
SEER*Abs database. Data entered in SEER*Abs, changes made to AFLs, and
changes made to the user list are stored in the main database. Reference data
are not stored in the main database and are not included in this backup.

Alt+F, arrows

Restore Main Database - overwrites the main database using a previously
created backup. You will be prompted to select the backup from your hard disk
or network.

Import Reference Database - updates the reference data from a database
created by the system administrator. You will be prompted to select the main
DB folder containing the reference data (a default folder may have been set in
your registry’s configuration).

Alt+F, arrows

Recreate Indexes — ensures that database indexes and tables are in sync.
Indexes are used by SEER*Abs to optimize database searches.

Recreating the indexes will ensure that the indexes and database are in sync. It
is a good first step to try if you notice odd results in searches or when filtering.
It should be very rare that this would need to be done.

Alt+F, arrows

Package Application for Technical Support - creates a compressed file
containing the files required by the Technical Support staff to track down an
issue. Use this option only if requested by Technical Support.

Alt+F, arrows

Change Password - allows you to specify a new password.




Shortcut

Menu Item

Alt+F, arrows

Set Current Facility - allows you to change the Current Facility used
throughout SEER*Abs. You may select a facility or set Current Facility to none.
Current Facility is used as the default facility in the worklist and, depending on
your registry’s configuration, it may be used as a default value for some data
entry fields. It may also be used in scripts that create extracts, download data
from your registry database, or perform other functions. Consult the SEER*Abs
system administrator at your registry to determine the ways in which Current
Facility is used.

Alt+F, arrows

Preferences - displays the User Preferences dialog.

Ctrl+Shift+Q

Exit — closes SEER*Abs. You will be prompted to save any unsaved changes.

Show Menu

Toolbar Icon

Shortcut

Menu Item

F1

Worklist = opens or returns you to the SEER*Abs worklist. When
you first login, the worklist filters are set to show outstanding
abstracting tasks (AFLs) for the current facility. AFLs for all
facilities will be displayed if you do not select a current facility.

F2

Editor - allows you to create new records. Abstract and
casefinding record layouts are defined for most registries; a short
abstract layout is supported but is only available if defined in your
registry’s configuration.

F3

Search - opens the Search page. If you have used the Search
page in this session, the filters and results most recently displayed
are restored.

Use this to search patient, facility, and physician data in the
SEER*Abs database. These reference data are extracted from the
registry’s main database or loaded from external files during
synchronization. Scripts maintained in the registry’s Configuration
determine the contents of the reference data.

F4

Synchronization - allows users to update SEER*Abs with data
from the registry’s data management system; and create extracts
to update the registry’s data management system.

Input Folder - displays the input folder (default folder used to
import data files)

Output Folder - displays the output folder (default folder used to
create extracts)




Action Menu

Shortcut Menu Item

Alt+A, arrows | Purge Archived Data - deletes archived AFLs and/or records older than that are
older than a period of time defined in registry configuration settings. Note: This
feature may be hidden in your registry’s configuration.

Alt+A, arrows | Your registry’s system administrator can customize the Action menu. Other
actions may be listed. If your registry’s configuration does not support any
actions, the Action menu will not be displayed.

Help Menu

Shortcut Menu Item

Ctrl+Shift+H User Manual - displays this document.

Ctrl+Shift+T Shortcuts - displays a list of keyboard shortcuts. Global shortcuts and shortcuts
specific to the current page will be listed.

Alt+H, arrows | Coding Manuals - Some of the SEER, NAACCR, FORDS, and Collaborative
Staging coding manuals have been distributed with SEER*Abs and can be opened
via the Help menu.

Alt+H, arrows | Version History - displays a dialogs showing the changes made to each release
of the application

Alt+H, arrows | About - displays system information including the installed version and credits.

Status Bar

A status bar is shown at the bottom of the screen. The contents of the status bar are described
below.

e Your username and the current facility are displayed on the left side of the status bar. The
facility will be used as the default for filters and some fields when entering data. If you
need to change the facility, select File > Set Current Facility.

e The name of the current module is shown on the far right side of the status bar. In the
example below, the user is viewing the Worklist and FAC-0010 is the Current Facility.

" Logged in as depryf at FAC-0010 (Testing Hospital) | | Showing Worklist |

¢ You may move back and forth from the record editor to other parts of the system without
closing the record. If a record is open in the editor:

o The center part of the status bar contains the edit failure for the current file (if any
edit is failing for it).



o The type of record is indicated by an ID prefix or the full record ID. If the record has
never been saved, only the prefix is shown. ABS is the ID prefix for abstract
records.

o Mod is displayed if the record has been modified but not saved.
o The number of failing edits will be shown in parentheses.
o The current status of the record is also displayed.

e The figure below shows the status bar as it would be displayed while editing an abstract
record that was saved and then modified. The modifications have not been saved. The (2)
indicates that there are two edits failing for the record.

|| Logged in as depryf at FAC-0010 (Testing Hospital) | [SEERAbs edit] Date of Diagnosis is required | ABS-000007 : Mod (2) - IN PROGRESS | Showing Editor |

Keyboard Commands

To access a menu using your keyboard, press Alt + a letter. To view the letter assigned to each
menu, only press the Alt key. A single letter will be underlined in each menu item. Alt + that
letter will open the menu. You may then use arrow keys or the key combinations listed on the
menu to access a specific menu item.

In addition to the shortcuts listed in the menus and toolbar icons, there may be shortcuts designed
specifically for the current page. Enter Ctrl+Shift+T to view a list of the currently available
keyboard shortcuts.

User Preferences

To open the User Preferences dialog, click on the Preferences under the File menu.
The following parts of the application can be customized:

e Startup - Toolbar: whether the toolbar should display large icons, small icons or no icons
at all. The F keys short still work even when the icons are not displayed (unless the F-keys
have been re-assigned to record editor actions, see Key Binding).

e Startup - Worklist: default filter for the worklist: display only the outstanding work, or all
the records (and Abstract Facility Leads if they have been enabled in your Registry).

¢ Record Editor — Key Binding: this is the most complicated feature in the Preferences; it
allows the 12 F-keys to be re-map to common action in the record editor like display the
lookup for the current field, display the documentation for the current field, initiate a
physician search, etc.. By default the F-Keys are used to access the main pages of the
application (Worklist, Editor, Search and Synchronization). If the F-keys are used for record
editor actions instead, they won't trigger the main pages anymore. In that case, the
Alt+Left and Alt+Right can still be used to go to the next and previous main page. The
figure on the next page shows the different option that can be assigned to the F-keys

¢ Record Editor — Lookups: simple customizations for the lookups.



¢ Record Editor — Text Panel: whether the text panel (for large text fields) is shown by
default when opening a record. Note that not all record types support a text viewer; that

depends on how your Registry configured the data entry forms.

¢ Record Editor - Info Panel: Whether the info panel (showing the record summary on the
top of the page) is shown by default when opening a record. Note that not all record types
support a record information panel; that depends on how your Registry configured the data

entry forms.

o Record Editor — Font Size: the default font size to use in the record editor.

Preferences - SEER*Abs

[t

L Worklist
Record Editor

- Key Binding
Lookups
Text Panel
Info Panel

“... Font Size
Input/Qutput
... Input Folder
Output Folder

F-+keys (F1 - F12) by default switch between pages, but they can be re-assigned to common actions in the editor,

(71 use Fkeys to switch between pages

(@) use F-keys to trigger record editor actions as spedified hereunder:

Fi

F2

F3

F4

F5

F&

F7

F&

F2

F10

Fi11

F12

Save Current Record
:Cnmplete Current Record
:Show Lookup for Current Field

i < Unassigned >

Close Current Record

Delete Current Record

Copy Current Record

Show Documentation for Current Field
Show Failing Edit for Current Field
Show Expanded Text for Current Field
[nitiate Patient Data Search

Initiate Facility Search

Initiate Physician Search

Initiate SEER *Rx

Initiate Hematopoietic Databases

Save & Close ] [ Cancel




Section 3: Worklist

The SEER*Abs worklist displays tasks related to records (abstracts and possibly some other types if
the application has been configured to support them) and Abstract Facility Leads (if they have been
turned on in your Registry). In SEER*Abs, an Abstract Facility Lead (AFL) is used to let an
abstractor know that an abstract is needed. An AFL is a request to abstract medical records for a
patient at a specific hospital or facility. The AFL may include data items describing the patient and
case.

AFL is an optional feature in SEER*Abs. If used, the AFLs are loaded from registry data. The AFLs
are listed in the worklist. You would open an AFL and review the information. You could then
create an abstract record from the AFL (some fields may be auto-filled using values in the AFL).

In addition to AFL tasks, all records created in SEER*Abs are listed as tasks in the worklist. It is
possible to have tasks for each type of record supported in SEER*Abs including abstract records
and records designed specifically for your registry. The task ID includes a prefix which identifies
the type of task. The prefixes can be customized for your registry, if desired. The prefixes used
for tasks in the default version of SEER*Abs are:

e AFL - Abstract Facility Lead. This “lead” indicates that an abstract is needed from a specific
facility for the patient.

e ABS - worklist task to finish an incomplete abstract record.

e There may be other types of tasks unique to your registry.

File  Show Action Help

rFy
7 Items Type: <ANY> v Status: <ANY> v | Fadity: [FAC-0001 |Q Text: | | [ Reset ]
Lasti\lame First Name M SSN Med Rec # Fadility Last Modified Linked Rec/AFL Status
KARL M  123-45-6789 ABC-3456  FAC-0001 04/21/2009 1:50 PM IN PROGRESS
DILLON CLAUDIA L | 990-00-0002 | 0000000002 | FAC-0001 | 04/21/2009 1:47 PM NOT ABSTRACTED
|| | aBs-ooo00z2 | KAy 1 | 990-00-0003 FAC-0001 | 04/21/2009 1:47 PM AFL-0003 COMPLETED
AFL-0003 | KAY QUINCY 1 | 990-00-0003 | 0000000003 | FAC-0001 | 04/21/2008 1:47PM  ABS-000002 ABSTRACTED
ABS-000003 | SUSANNE CLARK M | 990-00-0001 FAC-0001 | 04/21/2009 1:47 PM AFL-0001 IN PROGRESS
AFL-0001 | SUSANNE CLARK M | 990-00-0001 0000000001 | FAC-0001 | 04/21/2008 1:47PM | ABS-000003 IN PROGRESS
AFL-0006  VERA CLARC M | 990-00-0001 0000000001  FAC-0001 04/21/2009 1:29 PM NOT PROCESSED
| Logged in as depryf at FAC-0001 (TESTING FACILITY 1) | | showing Worlkdist
==

The worklist filters and columns can be configured, the worklist in your version of SEER*Abs may
not be exactly as shown above. Typically, there will be filters at the top of the worklist that allow
you to search for tasks by task type, status, facility, and other search fields. The results of your
search will be displayed in the table below. When you first log in, the worklist will display the
outstanding AFL tasks for the Current Facility.



Navigation Keys for the Worklist

If you prefer keyboard navigation to using the mouse, you may use the following keys to move
through the worklist and make selections:

Tab: press Tab to move from one filter to the next. Tab will also take you from the last filter to
the Reset button, and from the Reset button to the first task in the worklist.

Shift+Tab: use this to move in the reverse direction as Tab
Alt+Down: to view the choices in a drop-down menu

Arrow keys: to scroll through the choices in a drop-down menu; or to scroll through the tasks
in the worklist.

Enter: If your cursor is on a filter, pressing Enter will start the search using the settings in all
filters. If your cursor is on the Reset button, the filters will be reset to their default values. If
your cursor is on a worklist task, the task will open.

Searching the Worklist

Search criteria are entered in filters displayed at the top of the worklist. Your registry’s system
administrator can configure SEER*Abs to show different filters or change the way that the searches
are implemented. The following describes the default configuration in the distribution version of
SEER*Abs.

To search for tasks in the worklist:

1. Use the drop-down menu to select the Type of worklist task.

a. AFL - a request for an abstract from a specific facility. Data identifying the patient
and the cancer of interest are defined in the AFL. This type will not be shown if AFLs
are turned off in your Registry.

b. Abstract and Other Types of Records — The worklist includes records entered in your
installation of SEER*Abs. These include records that were entered but not completed,
records that were completed but not submitted to the registry, and records that were
submitted and archived. Archived records are available in the worklist until they are
purged using the Action > Purge Archived Data menu item.

c. Any - all of the above.

2. Select the Status. The values listed in the drop-down menu will vary based on the Type of
task selected in step 1; you cannot filter by status if Type = Any. Options that are
enclosed in brackets are combinations of other values, for example <Outstanding> lists all
open tasks for the selected data type; and <Any> lists tasks with any status for the
selected data type.

The following are the statuses for AFLs and Records as defined in the default distribution.
The values may not be exactly what you see in your Registry.

a. Default Statuses for AFL Tasks

10



Vi.

Vii.

Not Processed - have not started abstracting the case

In Progress — began abstracting but did not complete the abstract
Abstracted - created a complete abstract record for the case

Not Abstracted - determined that the case should not be abstracted

Archived - submitted the results of the AFL to the registry. The status of an
AFL is set to Archived when you export the AFL data. Archived AFLs are
retained in SEER*Abs for a period of time that is defined in registry
configuration settings. Archived data that have expired can be removed by
selecting Action > Purge Archived Data.

Outstanding - AFL tasks that have a status of In Progress or Not Processed.

Any - All of the above.

b. Default Statuses for Record Tasks

iv.

V.

In Progress - entered some but not all data in the record
Completed - entered all fields and marked the record as complete

Archived - submitted the record to the registry. The status of a completed
record is set to Archived when the record is exported. Archived records are
retained in the system for a period of time as defined in registry configuration
settings.

Outstanding — In Progress is the only outstanding status for records.

Any - All of the above.

If you are searching for tasks related to a particular facility, enter a value in the Facility

filter:

a. If you know the facility’s ID, type the ID into the filter. SEER*Abs Facility IDs are
the same as those in your central registry’s data management system. If your
registry uses SEER*DMS, you do not have to enter the FAC- prefix. Multiple IDs can
be entered separated by commas. You may press Enter to apply your changes to
the facility filter or Tab to another filter to enter additional search criteria.

b. Or click the Lookup ¥ to search the database for the facility ID.

Enter search text into the lookup’s filter. The lookup table and its search
feature are defined by registry configuration settings. You may sort the table
of search results by clicking a column header.

Double-click an entry to select it. If you prefer to use keyboard controls:
1. Press tab to move from the text search box to the list.

2. Use the arrow keys to move through the list.

11



3. Press Enter to select an entry.

4. The Text box is a generic, Google-style search box that can be used to search for tasks
based on fields displayed in the worklist. Registry-defined configuration files determine
which fields are searched.

5. Press Enter to apply the filter settings.

You may click Reset to return all filters to their default values and reload the worklist.

List of Tasks

The items that match the filter settings are displayed in a scrolling table just below the filters. The
columns displayed in this table are controlled by the configurations set by your registry staff.
SEER*Abs is shipped with the columns ID, last name, first name, middle initial, SSN, Medical
Record Number, Facility, Last Modified, Linked Record/AFL, and Status. The table can be sorted
by clicking the column header of any column. Click the column header a second time to reverse
the sort order.

A message is printed above the worklist table on the left side that shows the number of items
displayed. A configuration parameter determines the maximum number that will be displayed in
the worklist (500 is the default setting). A message will be displayed if the number of results
returned by your search exceeded the display limit.

If your search exceeded the display limit and you are looking for a particular task, it may be
missing from the items listed. You should add more detailed search criteria in the filters. For
example, if you enter a common last name into the “Text” filter and the search results exceed the
display limit then you should search by SSN, facility, medical record humber, or other search
criteria.

Contextual Menu for the Worklist Table

In addition to the Navigation keys, a contextual menu is available on the worklist when the right
button of the mouse is clicked. The following options are available:

e Open Selected Entity: opens the selected record or AFL; identical to double-click the
corresponding row. This option is enabled only if a single row is selected.

e Delete Selected Entities: deletes the selected records or AFLs; use the Ctrl key in
combination with the mouse to select multiple rows. If the rows that need to be selected are
together, then just select the first one with the mouse and drag down to the last one.

¢ Change Status of Selected Entities: changes the status of the selected entities. A dialog
shows the status of the selected entities, and the new status that should be assigned.

12



Change Status [th

Selected Statuses:
COMPLETED (2)

IN PROGRESS (1)
New Status:
IN PROGRESS
COMPLETED
ARCHIVED

| Ok | [ Cancel {

ke

Copy Cell to Clipboard: copies the content of the current cell to the clipboard. The
content of the clipboard can then be copied into other applications.

Copy Row to Clipboard: copies the content of the current row to the clipboard (fields are
comma-separated). The content of the clipboard can then be copied into other applications.

Copy Table to Clipboard: copies the content of the entire table into the clipboard (one line
per row, fields are comma-separated). The content of the clipboard can then be copied into
other applications.

Processing an AFL

To open and process and AFL in the worklist:

1.

2.

Open the Worklist. (Click the Worklist toolbar icon, select Show > Worklist or press F1.)

Use the filters to search for AFLs from a particular facility or for a specific patient (see the
Searching the Worklist section of this chapter).

Use your mouse or keyboard controls to select an AFL (see the Navigation Keys for the
Worklist section of this chapter).

Double-click anywhere on the AFL’s row or press Enter to open it.

The AFL will be displayed in a pop-up. The layout of this screen is defined by your registry’s
configuration settings. The snapshot below is based on the configuration shipped with
SEER*Abs.

13



6. Review the AFL and determine the appropriate action. The Abstract button is selected,
by default, when the AFL is first opened. Use tab or your mouse to move from one

@ s D =

Lead

Last |vEza | First[czanc | M[momcan

I BirﬂnDaheff|1950 | 55N|990000001 | Race Sex
DX Date [01 |/[01 |/[z008 | site[csas | Hist[sooo | Behav(z | Grade[s | Lat|1 |

Facility
Fadity [Fac-oo01 | [TesTive FacTLITY 1 |
Med Rec # Tumor Seq #
Doctor 1|PER-0001 | [TEsT, IESTL |
Doctor 2[pER-0002 | [TEsT2, TESTZ |
Doctor 3[pER-0002 | [TEsTs, TEsT3 |

[ Abstract |[ Not Abstract »> ] ’ Search H Cancel ]

button to the next.

a. To abstract the case, press Enter or click Abstract. SEER*Abs will open the
abstract editor. Data from the AFL and your abstractor ID may be auto-loaded
into the record fields, as defined in your registry’s configuration settings.
Instructions for entering and saving the record data are provided in the Editing a

Record section of this document.

b. If an abstract is not appropriate for this case, use your keyboard or mouse to

select Not Abstract.

c. Search - Takes you to the Search module with the filters set for the patient
described in this AFL. If your registry uses reference data, this allows you to see

Type a value or use the lookup to specify the Reason Not Abstracted.

Provide information specific to the case in the Detailed Explanation

section.

Click Update AFL Status to save these changes.

if your registry has any information about this patient already.

d. Cancel - exit the AFL without saving any changes.
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Opening a Record in the Worklist

To open a Record from the worklist in order to complete or review it:

1.

Open the Worklist. (Click the Worklist toolbar icon, select Show > Worklist or press
F1.)

Use the filters to search for the record as described in the Searching the Worklist section
of this chapter.

Use your mouse or keyboard controls to select a record (see the Navigation Keys for the
Worklist section of this chapter for more information).

Double-click or press Enter to open it.

The record will be displayed in the editor. Instructions for entering and saving the
record data are provided in the Editing a Record section of this document. The editor
might not be editable if the record has already been extracted out of SEER*Abs.

15



Section 4: Editing a Record

The SEER*Abs Editor allows you to create or modify records.

To create or modify a record:

1. Open a record in the SEER*Abs Editor using one of these methods:

a.

Abstract records may be created while completing an AFL worklist task as
described in the Processing an AFL instructions provided in Section 3: Worklist.

Or you may create a new record by selecting New Abstract or New <other record
type> from the File menu.

Saved records can be opened via the worklist as discussed in Section 3: Worklist.

Or you may go directly to the SEER*Abs editor by pressing F2, using the toolbar
icon, or by selecting Show > Editor. To open a record in the editor:

i. If you would like to create a new record, click the button corresponding to
the type of record that you wish to create (Abstract or a record defined
specifically for your registry).

ii. If you would like to re-open a record that you were working on recently,
select it from the Recent Records list. The last 25 records that were
modified in the Editor will be listed. Records listed with an asterisk are In
Progress.

2. Enter data into the fields. Refer to the subsequent sections of this chapter for an
overview of the editor and descriptions of the controls and features.

3. Registry-defined edits, system edits, and edit packages such as the SEER Edits may be
integrated into SEER*Abs. Edits are described in detail in the Edits to Validate Data
section of this chapter. To apply edits as you enter data:

a.

Configuration settings determine whether edits are executed as you move from
one field or tab to another. If edits do not execute as you move from field to
field, you may click Validate to execute edits for all fields.

To display a list of all edits failing for the record, click Show Errors. The edits
will be listed in the Message pane at the bottom of your screen.

4. Options for exiting and/or saving changes while editing a record:

a.

Save will save changes made in the current session. The current values in the
record will be written to the SEER*Abs main database. The record will remain
open in the record editor and the record’s status (In Progress or Completed) will
not be altered.

Complete will save your changes, flag the record as a completed record, and
close the record display.
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c. Close will close the record display. If you have made changes that have not
been saved, you will be asked if you want to save those changes. The record’s
status will not be altered.

d. You can actually navigate to any part of the system while you are editing a
record. The record will remain open in the editor. The status bar will indicate the
type of record, whether there are unsaved changes, and if the record has failing
edits. If you exit SEER*Abs you will be notified if unsaved modifications have
been made to the record.

Records can be opened and modified until they are exported (status = archived); you cannot
modify data once it has been archived and you cannot use SEER*Abs to modify records that were
created by other software. Archived records can be viewed in the editor in read only mode.
Archived records are completely removed from the SEER*Abs database when the Purge Archived
Data action is used. It is possible to modify the status of a record to recover from a mistake.

To modify the status of a record:
1. Select the record in the worklist by clicking one on its row.
2. Right click that row to display the context menu.
3. Select the option Change Status of Selected Entities.
4. In the option dialog, select the new status for the record.
5. Click OK.

This operation should be used with care; the record statuses define the workflow of the records,
modifying them through this mechanism override the normal workflow. It is not something that
should be done on a regular basis.

Accessing the Record Editor

If no record is open, a page is displayed that shows a summary of record counts and allows you to
create a record. This page can be customized. The screen shot below shows the default page, it
might look slightly different in your registry depending on your customized configuration.

The top left section is the Create New Record section. It contains a button for each record type
that can be created with the application. By default only Abstract records can be created, but the
application can be customized to support other Registry-specific types.

Under that section is the Recent Records section. The last 25 records that were opened are listed
in that section; double-click a record to open it. If a record as an asterisk after its label, it means it
is still in progress.

The right side of the page provides Records Counts. The entire section is fully customizable by
your Registry; the default version shows counts for the Abstract records split by their status, for
the current year, the previous year, and all the years together.
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a
Create New Record Record Counts
Abstracts (2012) Abstracts (2011) Abstracts (Other Years) Abstracts (Unk Year Dx) Abstracts (All Years)
IMPROGRESS: 1 INPROGRESS: 0O INPROGRESS: 0 INPROGRESS: 0 INPROGRESS: 1
COMPLETED: 1 COMPLETED: 0O COMPLETED: 0 COMPLETED: 0 COMPLETED: 1
Recent Records ARCHIVED: 0O ARCHIVED: 0 ARCHIVED: 0 ARCHIVED: 0 ARCHIVED: 0
ABS-000002 (DEPRY, CHARLENE)
ABS-000001 (DEPRY, FABIAN) *
Double-click a record to open it
Logged in as depryf at FAC-000051 (Testing Hospital) | Showing Editor

Record Data Entry Form

SEER*Abs has default screen layouts for abstract records. Other types of records can be defined
by your registry’s system administrator. All record layouts can be customized by staff at your
registry. If you experience any problems or would like adjustments, please contact your registry’s
SEER*Abs system administrator. The screen shot below is of an abstract record using the default
layout shipped with SEER*Abs.

The next screenshot shows the default data entry form for Abstract records. It is composed of the
following elements:

e A toolbar is displayed on the very top.

e Under the toolbar is the record’s summary panel. Whether that panel is shown, and which
fields are shown in the panel can be configured differently for each Registry.

e On the right-side of the screen is the text viewer used to display a read-only version of the
large text fields. Whether the text viewer is shown, and which fields are shown in its panel
can be configured differently for each Registry.

e The rest of the screen is the data entry form for the current record.
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F h
EA SEER Abstracting Tool G - E@ﬂ

File  Show Action Help

B i @X Hh 1 BRI %42 e ELEZIE wsg Ts=E>=
| Last: DEPRY First: FABIAN DOB:01/01/2000 SSMN: 123456789 Fac: FAC-000051 DX:01/01/2012 Site: C001 Morph: 8000/3

Demographics | Tumor | Staging | Summary TX | Hospital TX | DX Text | Paﬂ'1| Jump to Field | <select Field> | 2]
-
) )| | Staging (select | edit) s
PatID#l:I Prel:l Last|DEPRY | F|r5t|FABIBN | I'“II| | Some large text about staging.-..

S| 123456763 SEXQ Maiden | s | Lorem Ipsum is simply durmy text of
" . " . the printing and typesetting
o]0 senso 10 srnor .
Q Q Q Q Q Q Q / / industry. Lorem Ipsum has been the

industry's standard dummy text ewer
gince the 15005, when an unknown

m

Follow-up
printer toock a galley of type and

DOLCII wmlsmmsDQ AumpsyDQ Survgualigl:lg scrambled it to make a type specimen

book. It has survived not only five

FUSourCEDQ NEXtFUSrCDQ SEERTypeFUDQ FU Src Cntl l:lg centuries, but also the leap into

electronic typesetting, remaining

FoIIowRegl:I NPIFoIIowRegI:I essentially unch d. It was B

popularised in the 1%&03 with the

DC File #|:| DeathPIacel:IQ con|:| COD Rev #DQ release of Letraset sheets

containing Lorem Ipsum passages, and

m

more recently with desktop

Address at Diagnosis publishing scoftware like Rldus
PageMaker including wersions of

Nurm l:l Pre l:IQ Street| | Typel |Q POStl:IQ Suppl I:— Lorem Ipsum.
City | |Q State l:l Q ze I:I Cnty Code l:l 0 |Remark5 (select | edit) |

Surg Txt (select | edit)
Copy from Diagnosis
Radtn Beam (select | edit)

Numl:l Pre I:IQ Street| | TYDel |Q P"Stl:lg SL"D':"I: |4 T m | rl ;

far | 0 crmtal 1O 7 r“-.mr"mlall_‘ﬁ k2 Search| |[ Go ][ Clear ]

4| n 2

Current Address

| Logged in as depryf at FAC-000051 (Testing Hospital) | | AB5-0D0001 - IN PROGRESS | Showing Editor

The record type is shown on the right side of the status bar (ABS in the example above). The full
record ID is displayed only if the record has been saved. A complete description of the status bar
is provided in Section 2: Introduction to SEER*Abs.

Record Editor Toolbar

Icon Shortcut Description
= Ctrl+S Save the current record.
oy Ctrl+0 Complete and close the current record. Only completed records
can be extracted.
5 Ctrl+D Closg the.currgnt recqrd. If.it contains unsaved changes, a
confirmation dialog will be displayed.
% Ctrl+D Delete the current record.
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Icon

Shortcut

Description

Create a new record based on the value of the current record.
The current record will be closed. If it contains unsaved
changes, a confirmation dialog will be displayed. Not all records
can create other records; this option might be disabled for some
record types.

2=

Ctrl+T

Validates the current record. Although that behavior can be
customized differently in your registry, the form is also validated
every time a field looses focus.

Ctrl+R

Display the failing edits at the bottom of the page.

el

Ctrl+Minus

Decrease the font size of the editor. The default font size to use
can be changed in the User Preferences dialog.

Ctrl+Zero

Reset the font size of the editor. The default font size to use
can be changed in the User Preferences dialog.

Ctrl+Plus

Increase the font size of the editor. The default font size to use
can be changed in the User Preferences dialog.

Ctrl+<

Display only the text viewer (hiding the data entry form). The
default behavior of the text viewer can be changed in the User
Preferences dialog. Note all the record types support a text
viewer and this option might be disabled.

Ctrl+\

Display both the text viewer and the data entry form. The
amount of space used by the text viewer can be changed by
dragging the separation between the data entry form and the
text viewer panel. The default behavior of the text viewer can
be changed in the User Preferences dialog. Note all the record
types support a text viewer and this option might be disabled.

Ctrl+>

Display only the data entry form (hiding the text viewer). The
default behavior of the text viewer can be changed in the User
Preferences dialog. Note all the record types support a text
viewer and this option might be disabled.

Ctrl+?

Toggles the location of the text viewer between right side of the
data entry form and bottom side. The default behavior of the
text viewer can be changed in the User Preferences dialog. Note
all the record types support a text viewer and this option might
be disabled.
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Icon Shortcut Description

Hide the record summary panel. The default behavior of the
summary panel can be changed in the User Preferences dialog.

@ Note all the record types support a record summary panel and
this option might be disabled.
E| Display the Multiple Primary Calculator tool.
= Display the ICD Codes Lists tool.

Color Codes Used in the Record Editor

The SEER*Abs record editor displays data fields in different colors to highlight fields that contain
errors and fields that have been modified but not saved.

Colored Field

Description

[m=nl]

White indicates that the field does not have an error and has not been
changed since the last save.

A dark red indicates that the field is failing a system edit. The error message
is displayed when you mouse-over the field.

c200

A lighter red indicates that the field is failing an edit defined in the
configuration files. The message is displayed when you mouse-over the field.

caos

Yellow indicates that the field has been changed. The record has not been
saved since the change was made.

202

The field is shaded in green to indicate the current location of your cursor.

|Memnrial Hcspitall

Gray indicates that the field is read-only. Read-only fields are skipped when
tabbing during a data entry session.

|Hemurial Huspital|

A combined shaded of gray and green is used to indicate that a read-only
field has focus. You are allowed to select a read-only field so that you can
copy-and-paste the value of the field.

Entering Values into Data Fields

To enter values into data fields:

e You will be able to type values directly into most fields.

e Some fields will be auto-filled with default values based on your registry’s scripts. The
scripts will determine whether you can over-ride those values or not.
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Fields with light bulbs & have a lookup table associated with them. The lookup tables are
defined in registry configuration files.

EA Site - Lockup - SEER®Abs =TACIN X
[c4 |
Co:ie Description

C400 | Long bones of upper limb, scapula and assodative joints

»

C401  Short bones of upper limb and assocdative joints
C402 | Long bones of lower limb and assodative joints

m

C403  Short bones of lower limb and assodative joints

C408 | Overlapping lesion of bone & articular cartilage of limbs
C409  Bone & articular cartilage of limb, NOS

C410 | Bones of skull & face

C411  Mandible

C412 | Vertebral column

C413  Ribs, sternum & davide

C414 | Pelvic bones, sacrum & coccyx

C418  Overlapping lesion of bone & articular cartilage

C419 | Bone & articular cartilage, NOS

C420  Blood

C421 | Bone marrow

C422  Spleen

C423 | Reticuloendothelial system, MOS -

o Click the light bulb ¥ , press Ctrl+L or use the right-click contextual menu to open
the lookup.

o Enter search text. You may search for a code or for descriptive text.

o If you press Enter while entering search text, your search text will be copied into the
field. This is useful if you enter a code and use the lookup to confirm its meaning.

o To select a value from the list using keyboard controls, press Tab or Ctrl + Down to
move your cursor to the list and the arrow keys to move through the list. Press
Enter on the highlighted row or double-click an entry to select the value.

For some fields, the value may only be changed by modifying a related field. For example,
the figure below shows the ID and name of the Managing Physician. You may enter a value
into the ID field by typing the value or by using the lookup. The name field is read only and
will be auto-filled based on the ID.

ManagingF‘hysidan|I—‘ER—-:|12-:|-:| |'?,}' |Andersnn, Elizabeth |

If auto-forwarding is enabled, the cursor will automatically advance to the next field when
you enter the number of characters equal to the field’s length. (Field length is the
maximum number of characters that can be entered and may differ from the size of the box
on the screen.) If auto-forwarding is on, you should only need to use tab to move out of
fields that vary in length, for example, name, address, and text fields.

The cursor will not move forward if you enter a value that triggers a System edit. A system
edit fails when the value does not match the data type of the field (letters in a numeric field,
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for example). The system will beep and your cursor will stay in the field. You can either
enter a valid value or press Tab a second time to move your cursor forward.

o If edits do not execute as you move from field to field, click Validate to execute edits for all
fields. The edits are controlled by a configuration setting. The edits may be set to execute
as you move from one field to another; or the edits may be suppressed until you move to
another tab or click Validate.

Field Descriptions

Coding information and other descriptive text can be associated with fields. Descriptions from the
NAACCR coding manuals are included by default for NAACCR items. Registry staff may configure

SEER*ADbs to display descriptions for registry-specific fields. If a description is available, the field

label will be underlined when you mouse-over the label. Click the label, press CTRL-N or use the

right-click contextual menu when editing a field to display the description.

E2 Race - Description - SEER*Abs [DEMO] =HEE X
Race 1
Alternate Name Item# Length Source of Standard Column #
Race 160 2 SEER/CoC 177-178
Description i

Code the patientOs race. Race is coded separately from Spanish/Hispanic Origin [190]. All tumors for the same patient should have the same race codes. If the
patient is multiracial, code all races using RACE 2 through RACE 5 [161-164]. For coding instructions and race code historv see the current SEER Program Coding
and Staging Manual,.

Reference to Census 2000 definitions for ethnicity and race: http:/'www.ce:

Rationale

Because race has a significant association with cancer rates and outcomes, a comparison between areas with different racial distributions may require an analysis of
race to interpret the findings. The race codes listed correspond closely to race categories used by the U.S. Census Bureau to allow calculation of race-specific
incidence rates. The full coding svstem should be used to allow accurate national comparison and collaboration, even if the state population does not include many of
the race categories.

Codes
| 01 White
02 Black
03 American Indian, Aleutian, or Eskimo (includes all indigenous populations of the Western hemisphere)
04 Chinese

Autocomplete Feature
While entering text in a field, you may press Ctrl+Space to use the autocomplete feature.
SEER*Abs will search a list of terms based on the current word that you are typing.

When using the autocomplete feature, you may:

e Continue typing until there is a single term in the list. Press Enter. This is useful for
confirming spelling or syntax.

e Or when you see the term in the list, press Tab to move your cursor to the list itself. Scroll
through the list using the arrow keys. When the term is highlighted, press Enter.

o If you enter text that is not in the list, enter a complete term and press Enter. The value of
the field will be set to the text that you entered. You may want to ask your registry’s
SEER*Abs system administrator to add missing terms to the autocomplete list.
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Site Title |2 |

[acute |
]Q Hist T

Acute Lymphocytic Leukemia -
ide DQ Grady |2cute Monocytic Leukemia

Acute Myeloid Leukemia

Il:lg Ambid facute differentiated progressive histiocytosis

acute erythremias
"lyHIStD Mar acute erythremic myelosis

m

acute granulocytic leukemia

acute infantile reticuloendotheliocsis
acute leukemia

acute lymphatic leukemia

EVE'I:IQ L p| [EuTte lymphoblastic leukemia =

SEER*Abs supports multiple sets of autocomplete terms. Separate lists may be designated for
different fields, for example, there may be one list for histology and another for primary site. Or
terms from all lists may be made available in a field, for example, all terms are typically made
available when editing large text fields.

Multi-lines text boxes

Some fields can support multiple lines of text as shown below.

Remarks

This is a

mlti-line

text box

Pressing Enter in a multi-line field will add a line break and your cursor will stay within the field. To
enter a significant amount of text into a field, press CTRL+E or use the right-click contextual menu
to open a larger text editor.

A Remarks - Expanded Text - SEER*Abs AR X

This is a
multi-line
text bc:r.l

Dane ] ’ Cancel
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The autocompletion feature (CTRL+Space) can be used when entering text in the expanded text
editor. Click OK to close the dialog and apply the new text to the field, or Cancel to close the
dialog and leave the field as-is.

The number of characters per text field is limited by configuration settings. If you enter more than
the maximum allowed, an error message will be displayed at the bottom of the expanded text
window.

Physician and Facility Lookups

The facility and physician lookups are associated with search dialogs similar to the one shown
below. The physician and facility lookup have a Simple and Advanced search tabs. The Simple
Search tab has a single search field that is matched against multiple fields (a Google-style search).
The Advanced search tab has multiple fields to filter the list.

The Simple Search tab is configurable. Your registry’s system administrator can change the
configuration and control which fields are presented in the table, which fields are used in the
Simple Search, and the type of searching algorithm that is used (exact, contains, fuzzy, or a
lookup). To use the Simple Search, type a search string into the Text box and press Enter or click
Search. Click Reset to clear the search string from the Text box.

[ Lookup Facility - SEER® =R
Simple Search | Advanced Search
Search
Text |0 | (type text to search and hit 'Enter’ or didk the 'Search' button to start the search) %
Reset
jis] Name Type NPI FIN Address
FAC-006 | BRYORI COBRIGASS Clinic Clinic 1427244513 | 3651312883 | 01586 BISPEROMN CERIVERIM Street
FAC-016 = ADISENDRA ABRISTIRI Clinic Clinic 8317471087 2444737224 43508 BRYION AQUASHAN Street
FAC-030 | DAIDRETH BABU Clinic Clinic 3065655611 | 2135838014 | 73712 DAELELEE BALIFOROCK Street
||| FAC-036 DORTROLAN ARSHA Clinic Clinic 5226142720 7336336388 534358 DEMTRIOS ARRDARKIA Street
FAC-041 = ARKEBARLA AMIOCH Clinic Clinic 5401730725 | 2000150566 | 68020 ASTASANOR. ANDAIVEMOR Street
Results are sorfed by relfevance o criteria. Sorting by @ column will cause this order o be lost.
h

If you see the result you are interested in, type Ctrl+Down to move the focus from the search field
to the table of results, use the down key to go on the correct row and type Enter. You can also
double-click the row.

Note that the different fields that are searched from the Simple Search tab are "ORed” together.
The results are always sorted by relevance to the criteria, which the most relevant result shown
first in the table.

If the simple search is not enough, press Ctrl+Tab or use your mouse to move to the Advanced
Search tab. Components of the Advanced Search are also configurable. The registry’s
configuration determines which fields are available for searching and the type of search algorithm
used for each field.
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[ Lookup Facility - SEER* =HEC 1

Simple Search | Advanced Search

Namel

D

Search
| Type v WPI[1427244513 | FIN| | o | =
clinie o el
D Offi
Name cCt’_:r ree Type NPT FIN Address
Hospice
FAC-006 | BRYORI COBRIGASS Clinic = Clinic 1427244513 | 3551312883 | 01586 BISPERCMN CERIVERIM Street

Hospital
Lab
Medical Examiner

Mursing Home

Crganization &7

Resuilts are sorfed by relevance o criteriz. Sorting by 2 column will cause this order fo be lost.

Note that the different search fields of the advanced search are "ANDed” together. The results are
always sorted by relevance to the criteria, which the most relevant result shown first in the table.

If you prefer keyboard navigation to using the mouse, click Ctrl+Shift+T to view the shortcuts that
are specific to the physician and facility lookup.

Ctrl+Down | Move the cursor to the table of search results

Ctrl+Q Close current Window

Ctrl+R Reset the search criteria (clear search Text box or filters)

Ctrl+S Start the search

Ctrl+Tab Switch between Simple and Advanced search tabs

Enter If your cursor is in the top section with the search criteria, enter starts the search. If
your cursor is on one of the search results, it sets the field to the ID selected.

Escape Close the current Window

Shift+Tab | In the advanced search, go to previous field.

Tab In the advanced search filter, go to the next field.

Collaborative Stage Lookups

The default data entry form contains the 25 CSv2 fields with their corresponding lookups, although
the fields are hidden by default, until a site and histology are provided allowing the determination
of a valid Collaborative Stage schema.
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Collaborative Stage

Schema: <no schema defined, provide a valid site and histology >

CS Size |:| G Ext |:| G Eval D G LN |:| @ LMEval D § LNPos I:l @ LMExm I:l " Version Original
CS Mets l:lg Mets Eval |:| @ Mets Bone DQ Mets Brain DQ Mets Liver DQ Mets Lung DQ Version Current

Site Specific Factors

Show All Factors

Once a valid schema is provided (for example LipLower for C001/8000), the SEER required factors
are displayed and the labels are dynamically update:

Collaborative Stage

Schema: LipLower

C5 Size |:|Q Ext|:|Q Eval DQ LN |:|Q LN Eval DQ LN Pos |:| G LNExm DQ Version Original
C5 Mets l:l G Mets Eval |:| Q Mets Bone |:| Q Mets Brain |:| Q Mets Liver |:| Q Mets Lung |:| Q Version Current

Site Specific Factors
55F 1 |:| 7 [REQ] Size of Lymph Hodes
S5F 3 l:l Q [REQ] Levels I-I11, Lymph Nodes for Head and Neck
S5F 4 l:l Q [REQ] Levels IV-V and Retropharyngeal Lymph Nodes for Head and Neck
SSF 5 l:l@ [REQ] Levels VI-VII and Facial Lymph Nodes for Head and Neck
SSF 6 l:l Q [REQ] Parapharyngeal, Parotid, and Suboccipital { Retroauricular Lymph Nodes for Head and Neck
SSF 9 l:l Q [REQ] Extracapsular Extension Pathologically, Lymph Nodes for Head and Neck

SSF 11 |:| ) [REQ] Measured Thickness (Depth)

Show All Factors

The labels starting with [REQ] are the SEER required site-specific factors for that particular
schema, you may use the “"Show All Factors” button to display all the fields.

The content of the lookups change dynamically. SEER*Abs utilizes the CSv2 software developed by
the Collaborative Staging Task Force (cancerstaging.org) to create the content.

Lip, L e R Mel -
|| | 5 Site-Spedific Factor 1 Size of Lymph Nodes
C-x;de Description Note: Code the largest diameter, whether measured dinically or pathologically, of any involved

regional lymph node(s). Do not code the size of any nodes coded in CS Mets at DX,
o000 Mo involved regional nodes
001-879 001 - 979 millimeters {mm) C00.1 External lower lip (vermilion)
{Exact size of lymph node to nearest mm) C00.4 Mucosa of lower lip
aa0 930 mm or larger C00.6 Commissure of lip

{Indudes cases converted from codes 981-889 during conversion to Y0200)
Mot applicable: Information not collected for this case
938 {If this item is required by your standard setter, use of code 988 will result in an edit
errar)
990 Microscopic focus or fodi only and no size of focus given
991 Described as less than 1 centimeter {cm)”™
992 Described as "less than 2cm” or "greater than 1cm” or "between icm and 2cm™
993 Described as “less than 3cm” or “greater than 2cm™ or "between 2cm and 3cm™
994 Described as “less than 4cm” or “greater than 3cm™ or "between 3cm and 4cm™
995 Described as "less than 5cm” or “greater than 4cm™ or “between 4cm and 5cm™
996 Described as "less than 6cm” or "greater than 5cm™ or "between 5cm and 6cm™
997 Described as "more than &cm™

Regional lymph node(s) involved, size not stated
995 Unknown if regional lymph nodes invalved
Mot documented in patient record
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The following features are displayed in the collaborative stage lookups:

e Search box. You may search on the code or any text in the table. To select a value
once you have completed your search:

e If you have entered a valid code in the search box, press Enter. Text in the
search box will be copied into the field (do not use enter if you type descriptive
search text instead of a code).

e To move your cursor to the table, press Ctrl + Down. You can then scroll
through the table entries. Press enter to select.

e All shortcuts can be displayed by pressing Ctrl+Shift+T.

e The site and histology for site-specific surgery, schema for the collaborative stage fields,
field name, and field description.

e Site and histology - In the site-specific surgery lookup, the site and histology are
displayed in the title bar of the popup.

e Schema - The CSv2 schema name is displayed as a title in the lookups for
collaborative stage fields. In the example above, “Breast” is the schema.

e Field name and description — In the example above, the name is CS Site-Specific
Factor 1 and the description is ‘Estrogen Receptor Assay (ERA)’. The field names
and descriptions of the collaborative stage fields are returned by the CSv2
software and are not configurable. Descriptions are not available for all CSv2
fields.

e A section with the code and corresponding description; and a separate section of notes.
You may use the icons at the top right of the window or keyboard shortcuts to control
the display:

=]

Hide notes [Ctri+Right)

Show both side-by-side (Ctri+Up)

Show notes only (Ctri+Left)

e To hide notes: Use the rightmost icon that shows the right side of a book or
press Ctrl + Right Arrow.

e To show both notes and codes side-by-side: Use the middle “open book” icon or
press Ctrl + Up Arrow.

e To show notes only: Use the leftmost icon that shows the left side of a book or
press Ctrl + Left Arrow.

¢ You may also drag the center bar to adjust the size.

28



The default behavior of the Collaborative Stage lookups can be customized in the User Preferences
dialog.

Site-specific surgery lookup

Some fields might also be attached to a special site-specific lookup. Like the Collaborative Stage
lookups, its content is dynamically created once a valid site and histology have been provided.

{ CO01/8000 - Surgery Lookup - SEER* = | B 1

l | Oral Cavity

CodefDescription

00 Mone; no surgery of primary site; autopsy OMNLY

10 Local tumor destruction, NOS
11 Photodynamic therapy (PDT)
12 Electrocautery; fulguration {indudes use of hot forceps for tumor destruction)
13 Cryosurgery
14 Laser
No specimen sent to pathology from surgical events 10-14

20 Local tumor exdsion, NOS
26 Polypectomy
27 Excisional biopsy

Any combination of 20 or 26-27 WITH
21 Photodynamic therapy (POT)
22 Electrocautery
23 Cryosurgery
24 Laser ablation
25 Laser excsion
[ SFER Note:Codes 20-27 indude shave and wedge resection]

30 Wide excision, NOS
Code 30 indudes:
Hemiglossectomy
Partial glossectomy

40 Radical excdision of tumar, NOS
41 Radical exdsion of tumor OMLY
42 Combination of 41 WITH resection in continuity with mandible (marginal, segmental, hemi-, or total resection)
43 Combination of 41 WITH resection in continuity with maxilla (partial, subtotal, or total resection)
[ SEER Note:In continuity with or "en bloc™ means that all of the tissues were removed during the same procedure, but not necessarily in a single spedmen]

Codes 40-43 include:

Total glossectomy
Radical glossectomy

Specimen sent to pathology from surgical events 20-43

90 Surgery, NOS

99 Unknown if surgery performed; death certificate ONLY

The features of the Site-specific Surgery lookup are identical to one for the Collaborative Stage
lookups. Note that this lookup contains empty lines and comment lines (in blue); those cannot be
double-clicked to assign a value to the corresponding field (since they do not correspond to any
value).

The default behavior of the Site-specific Surgery lookup can be customized in the User Preferences
dialog.

Edits to Validate Data

Registry-defined edits, system edits, and edit packages such as the SEER Edits may be used to
validate fields while entering data. Failing edits do not prevent the record from being saved,
completed, or closed. When a field triggers an edit, the field is shown in red and the edit failure
message is shown in the status bar if the field is focused. The error message will also be displayed
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if you place your mouse over the field. Only one message is displayed if multiple edits are failing
for the field. All edits failing on the record are shown in the failing edits tables at the bottom of the
screen (the Show Errors button toggles the display of the table; by default it is not displayed).

There are two types of edits, internal system edits and edits defined in the configuration files.

¢ System Edits: Indicates that the value does not conform to database or system rules. For
example, the value may be an incorrect data type for the field (a letter in a numeric field) or
the value may not be in the field’s lookup. Configuration settings determine whether a field
can have a value that is not in the lookup. If a system edit fails, SEER*Abs will beep and
not move your cursor forward (correct the value or press Tab a second time to move
forward). Examples of system edits:

o a numeric field contains characters that are not digits
o a Boolean field contains a value other than “0” or “1”
o a date field is not in the *"mm/dd/yyyy” format

o a field contains a physician or facility ID that does not exist in the SEER*Abs
physician or facility lists.

o a field associated with a lookup contains a value that is not in the lookup table (and
the configuration for the field requires a value in the lookup)

e Edits included in your registry’s configuration: These include edits defined by registry
staff, SEER Edits, and other edit packages that may be integrated into SEER*Abs. SEER
Edits are distributed with SEER*Abs, but are turned off in the default configuration.

A field is highlighted in dark red if it fails a system edit. A lighter shade of red is used for fields
failing configuration edit. The following screenshot shows a system edit failing on the field “Race
4" because the value “"XX"” is not in its lookup; and a SEER*Abs edit failing for the Maiden name,
notice how the sex field is also in red because both fields are involved in the edit.
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B SEER Abstracting Tool [= [ B [t

File  Show Action Help

P50

=y —
Yy

B @ OB % q Tem,:ra;|,:4‘ Infor =g Took: [§ [
| Last: DEPRY First: FABIAN DOB: 01/01/2000 SSN: 123456789 Fac: FAC-000051 DX:01/01/2012 Site: C001 Morph: 8000/3

Demographics (3) | Tumor | Staging | Summary T | Hospital TX | DX Text | Paﬂ'1| Jump to Field | <select Field> | L2
-
] || Staging (select | edit) Il
PatID#l:I Prel:l I‘ESt|DLPRY | F|r5t|FABIBN | I'“II| | Some large text about staging.-..

55M (123456785 | Sex DQ MaldenlJON‘ES | Ahasl | Lorem Ipsum is simply durmy text of
" . " . the printing and typesetting
B0 10 el [0 swnre 0 swnoer .
Q Q Q Q Q P Q Q / /2 industry. Lorem Ipsum has been the

industry's standard dummy text ewer
gince the 15005, when an unknown

m

m

Follow-up
printer toock a galley of type and

DOLc,r,r vimlsmmsDQ AumpsyDQ SueruaIityl:IQ scrambled it to make a type specimen

book. It has survived not only five

FUSouroeDQ NextFUSrcDQ SEERTypeFuDQ FU Src Cnt |:|Q centuries, but also the leap into

electronic typesetting, remaining

FoIIowRegl:I NPIFoIIowRegI:I essentially unch d. It was

popularised in the 1%&03 with the

DC File #|:| DeathPIacel:IQ con|:| COD Rev #DQ " || |release of Letraset sheets

containing Lorem Ipsum passages, and
more recently with desktop

Address at Diagnosis publishing scoftware like Rldus

PageMaker including wersions of

Murn l:l Pre l:IQ Street| | Typel |Q POStl:IQ Suppl I: Lorem Ipsum.
city | 0 ste| Qo[ | cyeode| @ |Remark5 (select | edit) |

Current Address 0 e x

o

4 = S } m | 2 Search| H £ ][ Clear]

-
ID Group Message

EDIT-001 SEER*Abs | Maiden name provided, sex must be 2 (FEMALE)

Field'Race 4 | System | Value is notin corresponding lookup

| Logged in as depryf at FAC-000051 (Testing Hospital) | | AB5-000001 : Mod (2) - INPROGRESS | Showing Editor

To view a list of all edits failing for the record, click Toggle Errors View button. This button is a
toggle to show or hide the error panel at the bottom of the screen. The error panel shows the Edit
ID, Group, and Message for each edit that is failing. Double-click a row to open the Edit
Information dialog for that particular edit.

The number of edits failing in the record is displayed on the right side of the status bar. If your
record layout uses a tabbed interface, the number of fields failing edits is shown next to the tab
name. In the example, 3 fields are related to failing edits. Maiden name and sex are related to
EDIT-001; and Race 4 is related to the Field Race 4 edit. In this example, there are 3 fields related
to 2 edits that are failing for the record.

To view more information about a failing edit:
e Use the Ctrl+P shortcut

e Right-click on the field to bring up the contextual menu and select the View Failing Edit
Info option

o If the failing edits are displayed at the bottom of the page, you can double-click a given
row.
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The Edit Information dialog shows the documentation for the current edit; it also contains other
data like the edit’s history, code, dependencies, etc... The following screenshot shows the
documentation of a SEER edit, pure SEER*Abs edits usually have less documentation available.

* —yl=l

{ Sequence_MNumber--central -

ID: Sequence_Number--central MName: Sequence Mumber--central
Group: SEER Category: Field Severity: ©

Msg: Sequence number—central is not valid,

Documentation | History | Code | Contexts | Dependendes

Valid codes for Sequence number--central[380] are 00-59,&0-88,98,99.

00 = One primary only in the patient's lifetime
01 = First of two or more primaries

02 = Second of two or more primaries

ete. (Actual number of this primary)

59 = Fifty-nineth of fifty-nine or more primaries
99 = Unspecified or unknown seguence number

60 = Omly one non-malignant tumor or central registry-defined neoplasm
61 = First of two or more non-malignant tumor or central registry-defined neoplasms
62 = Second of tow or more non-malignant tumor or central registry-defined neoplasms

87 = Twenty-seventh of twenty-seven

88 = Unspecified or unknown sequence number of non-malignant tumor or
central registry-defined neoplasms

98 = Cervix carcinoma in situ (CIS/CIN III, Diagnosis Years 1996-2002)

Close

Text Viewer

The Text Viewer allows you to view text fields while coding other fields. The Text Viewer is a read
only panel within the editing window. The Text Viewer stays on the screen when you switch from
one data tab to another. Your registry’s configuration defines the fields shown in the Text Viewer.
The viewer was designed for the display of large text fields, but any field may be shown in the
viewer.

Use Jump To Field to view a specific field in the Text Viewer. The scrollbar will adjust so that the
selected field is shown at the top of the panel.

To find text in any field, enter text in the Search box and click Go. The Text Viewer will adjust to
show the first occurrence of the term. Click Go again to search for the next occurrence. Click
Clear to reset the search box.

There are some very specific shortcuts for the text viewer; those can be viewed by using
Ctri+Shift+T:

e Ctrl+<: show only the text viewer (hide the editor).
e Ctrl+>: show only the editor (hide the text viewer).

e Ctrl+\: show both the editor and the text viewer.
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e Ctrl+?: toggle text viewer location between right side and bottom side.
e Ctrl+3J: Jump to a particular text box in the text viewer.

e Ctrl+F: Initiate a search in the text viewer.

e Ctrl+K: Search the text boxes with the current search text.

e Ctrl+M: Clear the current search.

e Ctrl+H: Sets the focus on the record editor.

Jump to Field <Select Field= L2

Staging [ select | edit) i

Some large text sbout staging. ..

Lorem Ipsum is simply dummy text of
the printing and typesetting
industry. Lorem Ipsum has been the
industry's standard dummy text ewver

gince the 15003, when an unknown

m

printer toock a galley of type and
scrambled it to make a type specimen
book. It has survived not only fiwve
centuries, but alsoc the leap into
electronic typesetting, remaining

egsentially unchanged. It was

popularised in the 13803 with the
release of Letraset sheets
containing Lorem Ipsum passages, and
more recently with desktop
publishing software like Aldus

PageMaker including wversions of

Lorem Ipsum.

Remarks (select | edit)
| |
Surg Txt (select | edit)
| |

Radtn Beam (select | edit)

Search| |[ Go ][ Clear]

-

Record Summary Panel

The record summary panel shows the value of key fields for the current record.

the top of the editor. Not all record types support this feature.

When a record is opened for the first time, the panel will only show the labels.

It is displayed on

| last: First: DOB: // SSN: Fac DX: // Site: Morph: /

The value will appear as the data entry form is populated.

| Last: DEPRY First: FABIAN DOB: 01/01/2000 SSM:123456789 Fac: FAC-0010 DX:01/01/2011 Site: C001 Morph: 8000/3

The panel can be hidden using the Toggle Info View icons in the toolbar.
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The behavior of the panel can also be customized in the User Preferences dialog.

HematoDB Multiple Primaries Calculator Tool

The Multiple Primaries Calculator is the last step of a more complex procedure to identify multiple
primaries. Please refer to the Hematopoietic Manual for more information.

A HematoDB Multiple Primaries Calculator - SEER*Abs l = 2
Code 1 I:I Code 2 | | | Calculate View Manua

Enter two disease codes and dick Calculate or press Enter. You may enter histology codes (9999) or histology /behavior (3999/9).

The Multiple Primaries Calculator was designed to be used in conjunction with the coding manual. Follow the rules and workflow
in the manual prior to using the calculator. Use the Multiple Primaries Calculator when the rules instruct you to do so.

k e —— — —

To use the Multiple Primaries Calculator:
1. Enter two histology codes with or without the behavior (so "8000” or “8000/3").

2. Click the Calculate button or type Enter.

HematoDB ICD Codes Tool

The ICD Codes Lists shows the different ICD-0-3 codes related to Hematopoietic and Lymphoid
diseases with their names, alternate names and corresponding ICD-10 and ICD-9 codes.

The view can be toggled to view the codes by ICD-0-3, by ICD-10 or by ICD-9.
To search of a term:

1. Type the term in the Search text box.

2. Type Enter or click the Search button.

3. Only the row containing that term are retained in the table, and the term is displayed in red
everywhere it is found.

To reset the search and display all the rows again, click the Reset button.

It is also possible to view more information about a particular code by double-clicking its row. This
will automatically open the Search page and initiate a search in the Hematopoietic and Lymphoid
database.
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.
A HematoDB ICD Codes - SEER*Abs S — =HACA X

Search text || Display codes by @) ICD-O-3 (D) ICD-10 (T ICD-9 (2]
-
ICD-0-3 Code Alternate Names ICD-10 Code(s) ICD-9 Code(s)

965143 Lymphocyte-rich classical Hedgkin disease, lymphocyte predominance, NOS [OBS] C81.7 Other Hodgkin's disease 201.4 Lymphocytic-histiocytic -
Hodgkin lymphoma Hodgkin disease, lymphocytic-histiocytic predominance [OBS] predominance

Hedgkin disease, lymphocytic-predominance, diffuse [OBS]

Hodgkin lymphoma, lymphocyte-rich

LR-cHL

LRCHL =
9652/3 Mixed cellularity dassical Classical Hodgkin lymphoma, mixed cellularity, NOS 31,2 Hodgkin's disease, mixed 201.6 Mixed cellularity
Hodgkin lymphoma Hodgkin lymphoma, mixed cellularity, NOS cellularity

MC-HL

MCCHL
9653/3 Lymphocyte-depleted Classical Hodgkin lymphoma, lymphocyte depletion, NOS C81.3 Hodgkin's disease, lymphocytic | 201.7 Lymphocytic depletion
dassical Hodgkin lymphoma Hodgkin lymphoma, lymphocyte depletion, NOS depletion

LD-HL

LDCHL
9654/3 Hodgkin lymphoma, C81.3 Hodgkin's disease, lymphocytic | 201.7 Lymphocytic depletion
lymphocytic depletion, diffuse fibrosis depletion
9655/3 Hodgkin lymphoma, C81.3 Hodgkin's disease, lymphocytic | 201.7 Lymphocytic depletion
lymphocyte depletion, reticular depletion
9659/3 Modular lymphocyte Hodgkin lymphoma, nedular lymphocyte predominance C31.0 Hodgkin's disease, lymphocytic | 201.4 Lymphocytic-histiocytic
predominant Hodgkin lymphoma Hodgkin paragranuloma, nodular [OBS] predominance predominance

Hodgkin paragranuloma, NOS [CBS]

MLPHL
966143 Hoddgkin granuloms [0BS]
9662/3 Hodgkin sarcoma [0BS]
9663/3 Modular sclerosis dassical Classical Hodgkin lymphoma, nodular sderosis, NOS C81.1 Hodgkin's disease, nodular 201.5 Modular sclerosis
Hodgkin lymphoma Hodgkin disease, nodular sderosis, NOS sclerosis

Hedgkin lymphoma, nodular sderosis, NOS

Modular sclerosis Hodgkin lymphoma

MNS-HL

MNSCHL
9664/3 Hodgkin lymphoma, nodular | Classical Hodgkin lymphoma, nodular sclerosis, cellular phase C81.1 Hodgkin's disease, nodular 201.5 Modular sdlerosis
sdlerosis, cellular phase sclerosis

Creating a Record from another Record

You may create a new record based on an existing record. You will be able to auto-fill selected
fields by copying values from the current record into the new record. This was primarily designed
for creating an abstract record from a casefinding record, but it can be used to create a second
abstract record to reduce data entry for multiple primaries.

To create a record from another record:

1. Open an existing record in the SEER*Abs Editor. This will be referred to as the
“original” record in these instructions.

2. Click Copy.
3. If there are unsaved changes, you will be asked if you would like to save them.
4. Select the record type for the new record.

5. If you are creating an abstract from an abstract, you may copy all data or sections of
data from the original record into the new abstract. A dialog like the one shown below
will be displayed. Select the sections of data that you would like to have copied from
the original record into the new abstract. The copy feature is a configurable feature in
the scripts for creating records. The registry’s system administrator must ensure that
the appropriate elements are copied.
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User Input - SEER*Abs [DEMO] B3

b

Which section(s) should be copied aver?

Demographic

CTC

Admission

RX Hospital Treatment
Summary

Pathology

Diagnosis Text

Keyboard Shortcuts

In addition to the global shortcuts, there are several shortcuts specific to editing record data.
Press CTRL+Shift+T to view the Shortcut Help.

Key Command

Action

Ctrl+D

Delete the record currently being edited. This is the same as clicking Delete.

Ctrl+Down Arrow

Go to next row in the editor. From the last row on a tab, this goes to the first row in the
next tab. From the last row on the last tab, this goes to the first row on the first tab.

Ctrl+E

Display the Expanded text window for a multi-line field.

Ctri+L

Display the field lookup if one is defined for the current field. It is the same as clicking
the light bulb.

Ctrl+Left Arrow

Go to the previous field in the row. From the first field in the row, this goes to the last
field in the previous row. This will also move across tabs. Same as Shift+Tab.

Ctrl+N Display documentation for the current field, if available.

Ctrl+0 Save the record currently being edited. Change the status to Completed. Close the
record. This is the same as clicking Complete.

Ctrl+Q Close the record currently being edited without saving. Same as clicking Close.

Ctrl+R Switch between viewing and hiding the edit errors. Same as Show/Hide Errors.

Ctrl+Right Arrow

Go to the next field in the row. From the last field in the row, this goes to the first field
in the next row. From the last field in the last row on the tab, this goes to the first field
in the first row on the next tab. From the last field in the last row on the last tab, this
goes to the first field in the first row on the first tab. This works the same as Tab.

Ctri+S

Save the record currently being edited. This is the same as clicking Save.

Ctrl+Shift+Tab

Go to the previous page. From the first page, this goes to the last.

Ctri+T

Validate the record currently being edited (force the edits to be recalculated). This is the
same as clicking Validate.

Ctrl+Tab

Go to the next page. From the last page, this goes to the first.

Ctrl+Up Arrow

Go to the previous row in the record editor. From the first row on a tab, this goes to the
last row in the previous tab. This works across tabs.

Enter Go to the next field. For multi-line fields, add a new line in the current field. This is
similar to tabbing out of the field except when in a multi-line field.

Shift+Tab Go to the previous field in the row. From the first field in the row, this goes to the last
field in the previous row. This will also move across tabs. Same as Ctrl+Left arrow.

Tab Go to the next field in the row. From the last field in the row, this goes to the first field

in the next row. This will also move across tabs. Same as Ctrl+Right arrow.
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Section 5: Searching the Reference Data

The SEER*Abs Search page allows you to search patients and records reference data, facilities,
physicians, SEER*Rx drugs and Hematopoietic and Lymphoid diseases.

Reference data are transferred from registry data via the synchronization module. Scripts
maintained in the registry’s configuration define the amount and type of data that are made
available as a reference. These scripts can be configured to load the data directly from the
registry’s database during synchronization; or the data can be loaded from external files. Your
registry’s system administrator will provide you with instructions for updating the reference data.

The Search page consists of five tabs with tab-specific filters at the top of the page. As is true
throughout SEER*Abs, the columns and filters are defined by registry configuration settings.
SEER*ADbs is shipped with the filters and columns shown in the snapshots used in this manual.

To search for reference data:
1. Go to the Search Page using one of these methods:
a. To go to a specific tab and clear all filters:
i. Patient Data tab: Select File > Search Patient Data or press Ctrl+Shift+P
ii. Facility tab: Select File > Search Facilities or press Ctrl+Shift+F
iii. Physicians tab: Select File > Search Physicians or press Ctrl+Shift+Y
iv. SEER*Rx Drugs tab: Select File > SEER*Rx or press Ctrl+Shift+D

v. Hematopoietic and Lymphoid Database: Select File > Hematopoietic
Database or press Ctrl+Shift+1I

b. Or press F3 to return to the Search page from any part of the system. The
previously used filter settings will be restored.

2. Enter values in the filters at the top of the page. For the Patient Data, Facilities and
Physicians, your registry’s configuration determines which fields are available as filters, the
type of search algorithm used for each filter, and the columns displayed in the search
results. The SEER*Rx Drugs and Hematopoietic and Lymphoid Diseases have a single
“Google-style” search field.

3. Click Search or press Enter to apply the filters.

4. If you need to cancel a search, press Escape. If searches are excessively slow, please
contact your registry’s system administrator for technical support.

5. For the Patient Data, Facilities and Physicians, you can double click an entry or use
keyboard controls to view data for an individual record, patient set, facility, or physician.
The keyboard controls are described below:

a. Press Tab to move your cursor to the results table.
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b. Use the up and down arrows to move your cursor to a specific item in the table.
c. Press Enter to open the data item.

6. If you open a data item, the data will be displayed using a screen layout defined in the
registry configuration settings. Reference data are displayed in read only mode. Click the
Close button at the top right of the page to close the window.

7. Click Reset to reset the filter values to blank.

Search results matching your filters will be shown in the table. The total number of results is
displayed just above the table. If you exceed the maximum number of allowed results, the
message “(maximum number of results was reached)” will follow that number.

The results are initially sorted based on a matching score. You can sort by another column by
clicking the column header; click it again to change from ascending to descending order. Clicking
Search or Clear will reset the sort order to be based on score.

Patient Reference Data

r ~
B SEER Abstracting Tool =N X
File 5Show Action Help
L -.r
ry
Patient Data | Fadilities | Physicians | SEER*Rx | Hematopoietic and Lymphoid Database |
Last Name First Name | | ssn| Med Recs | | o @
—
Last Name First Name M SSh Race DOB Sex Medical Rec #
BREL AMADOR B 000887707 01  01,01/1950 Male MRN-6708685128
REC-000061 naacor | BREL CUHAIMOR A | 000302623 01  01/01/1950 Male MRN-3742674537
REC-000391  naaccr | BREL AVATTHARL B | 000747543 @ 01 | 01,/01/1950 @ Female | MRN-3305347563
REC-000034 naaccor  DREL ASTASAMOR A 000445530 01 01/01/1950 Male MRM-3503120168
REC-000247  naaccr | DREL ADISEMDRA A | 000675017 01 01/01/1950 Male MRN-3612014166
REC-000378 naaccor | DREL ARDEGORU B 000232537 01 01/01/1950 Male MRM-1718552138
Results are sorted by relevance to criteria. Sorting by 2 column will cause this order to be lost.
| Logged in as depryf at FAC-000051 (Testing Hospital) | | Showing Search
.

The Patient Data tab can be used to search for records and consolidated patient data loaded from
registry data. These may include any types of records (abstracts, pathology reports, etc).
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Typically, reference records only include records that have not been consolidated with other patient
data in the registry’s main database. The consolidated patient data are represented as “patient
sets”. These are data that have been consolidated from abstracts, casefinding, pathology, and
other records submitted to the registry.

Facility and Physician Reference Data

The Facility and Physician search tabs can be used to search for data loaded from registry data.
These are typically the same facilities and physicians are available in lookups; and the same fields
may be available in both the reference data search and lookups. However, registry configuration
settings control the reference search tabs and lookups. It is possible that certain criteria will be
used to exclude physicians or facilities from lookups (for example, inactive facilities might be
excluded). Registry configuration settings also determine the fields shown in both the reference
data search and lookup.

The screenshot below shows the default Facility search tab. No search criteria are provided, so all
the available facilities are displayed.

EA SEER Abstracting Tool =NACI X

File Show Action Help

| Patient Data | Facilities | Physicians | SEER*Rx | Hematopoietic and Lymphoid Database |
Name | | Type | - | MNPL | | FIN | | Address | | jin] | | (?]
_—
] Name Type NPT FIN Address City State  Zip
AUDRIANI AVELWEOMER Other Fadility Other Fadlity 3451117710 0723652848 43456 CUHAIMOR ARSHNICK Street ARTUS City MD 15760 =«
FAC-002 DHAR BRADI Hospital Hospital 5168331272 | 5077673215 64082 ARIMRALDIL DULE Street DAURGATO City MD | 22240
FAC-003 ALHAPQ BESESTAN Other Fadility Other Fadlity 3871866101 | 3603514128 | 52404 BERI DALIN Street DORTROLAN City MD 20275
FAC-004 BARCYN ANDAIVEMOR Lab Lab 1456451414 | 4872233428 33354 ARDER DULKYARGOR Street AMIOCH City MD 24685
FAC-005 AURGASS CUDEGAN Rad Therapy Unit Rad Therapy Unit | 1246664808 | 2673246703 | 30315 BISIRAH AGUILAC Street BESESTAM City MD 20621
FAC-006 BRYORI COBRIGASS Clinic Clinic 1427244513 | 35651312883 01586 BISPEROMN CERIVERIM Street AINIOMMNU City MD 15666
FAC-007 AVAGORA AINIOMNU Mursing Home: Mursing Home 4022506768 | 6252043341 | 75562 AIST DHAR. Street DAHRAIG City MD 20120 |
FAC-008 ARAVIV ARLI Organization Organization 5807262256 7541768073 35360 BELEBRON ARIS Street AINIOMMNU City MD 87558 3
FAC-009 ALABHEL DATRODDYN Doctor Office Doctor Office 4547235627 | 6110220420 @ 23035 ADRIST AMATH Street CAERINO City MD 40712
FAC-010 CATHAVILIL CILYN Hospital Hospital 6126348631 6766220070 | 01728 BISPEROM BABRON Street DERCISIRINM City MD | 67202
FAC-011 AVELEB AMIROSCHKA Medical Examiner Medical Examiner = 6142243352 | 0404311383 | 11126 DAHRAIG AIDORAQI Street AYISSA City MD 10161
FAC-012 DOROLASIRE CHINTAMNN Hospice Hospice 1581027268 | 0860246253 14244 AYARONM AMAS Street BRIADANTH City MD | 01304
FAC-013 ARADI CEDSTLIMO Mursing Home Mursing Home 0577252216 | 7237461775 | 34173 CAEM CUDREYGO Street BELGAN City MD | 63550
FAC-014 BELEBROM DYMAR Doctor Office Doctor Office 8418632478 2177733165 42506 DINDRINSOMN CAEVE Street DOMBREE City MD 21632
FAC-015 DIATIVOS CHIEREBDIN Medical Examiner Medical Examiner | 5336436822 | 8557151776 | 87657 DULANOR AMMDAS Street AIDORAQT City MD 27611
FAC-016 ADISENDRA ABRISTIRI Clinic Clinic 6317471087 2444737224 43508 BRYION AQUASHAN Street AUDRIANI City MD 52132
FAC-017 CUDEGAN DATHANHIR. Lab Lab 0536510715 | 3463705141 | 27157 BEYAREE ATIR Street CEDSTLIMO City MD 76676
FAC-013 BABRON DHAR. Organization Organization 2363154312 5600062873 53078 CALIDRIM COMNMIGURA Street BRIBOROM City MD 71884
FAC-019 BEREZAED AMAS Medical Examiner Medical Examiner | 7668601035 @ 1484075687 | 85087 CADI AGUILTHIR Street ARLI City MD 11081
FAC-020 DONIVEM AGOLOD Other Fadility Other Fadility 1384550300 @ 3163514852 05312 ARYSSA DAELELEE Street AIDRASS City MD 52268
FAC-021 BEYA BANTI Treatment Center Treatment Cen... | 3120402346 | 84251773564 23304 AKIN ARAMORTRIN Street AAKKAS City MD | 07027
FAC-022 CHINTANM BESESTAN Lab Lab 3150380321 8477555155 | 52565 AMAS ANDAIDRAIA Street AMDRITH City MD | 86181
FAC-023 DOLMITILYA DOLNITILYA Medical Examiner Medical Examiner | 7366447232 | 3686358663 | 35202 BARA DREZAIRA Street ALHAESTAH City MD | 41631
FAC-024 ADER. ANIOMBERIAN Hospice Hospice 1546062808 | 1234257333 08484 AYARONMN DAGOLATH Street CIVEMAS City MD | 88352
FAC-025 BELGAN ABRIOS Medical Examiner Medical Examiner | 0462336742 | 1314067288 | 71480 ALTHINAGON ARANDA Street DAGOLATH City MD 24120
FAC-026 ABRIOS ANDAIDRAIA Lab Lab 7433732787 4720867340 | 75556 ARAMDA BEYA Street CAIDOBRIOS City MD 23083 | T
Results are sorted by relevance to criteria. Sorting by a column will cause this order to be lost.
| Logged in as depryf at FAC-000051 (Testing Hospital) | | Showing Search

The screenshot below shows the default Physician search tab. The search criteria are any license
number containing “XYZ-6".
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B SEER Abstracting Tool

File Show Action

Help

| Patient Data | Fadilities | Physicians | SEER*Rx | Hematopoietic and Lymphoid Database |
Last Name I:I First Name| | MNPL | | License # |XY2—€ | ID| L)
Results: 60
D Last Name First Name Middle NPT License # Specialties Address City State Zip
DAPHION L 6375304013 XYZ-66275243356 24026 CONYAMN ARADIS... BABILMAMA City MD 31545 | =«
PER-008 BESIRAQ BERFEL A 1405811823 | XYZ-6103001142 05483 CUDEGAN DURIA... | BANTI City MD 50731 | |
PER-009 | COND CORE [ 7105635688 | XYZ-6822752264 41301 CHIEREBDIN ARLL... | CHADRAMAN City MD 74754
PER-013 ARSIRI DHURNOROTT A 1548654766 | XYZ-6432275030 56560 ARSHMICK DONIV... = BORARG City MD 67054
PER-039 | ALHAPO CADFANTE D 4110356315 | ¥YZ-6102268087 33347 CIVEMAS CEDSTLI... | CRYSIN City MD | 62333
PER-045 | DRIST DAHIA D 7201720858  XYZ-64306007241 52372 ARADI BELEBROM... | BREZUR City MD | 23785 || _
PER-050 | DAMIMTHOR ARDER C 7558113502 | XYZ-6337051114 75776 DAMINTHOR. CAT... | BESIRAQ City MD | 05306 |
PER-053 | BRYION BEREZAED A 3236944024  XYZ-6358786210 33361 ARAVECOMBAN CE... = ALABHEL City MD | 24454
PER-077 | CUDREIRIT BEYAREE B 4455641811 | XYZ-6665823532 53577 COBRIGASS BEYA... | CRABILTIA City MD 33252
PER-087 ALDDEGIM BREZLR. A 1818543574  XYZ-6687588227 14471 ALGANIA DATHA... = AINIOMNU City MD 68835
PER-088 | ADALIFAI ASTASAMOR [ 1712055024 | XYZ-6387513267 13830 CHADRAMAN CUH... | AYISTASH City MD 61805
PER-097 BRASH ATIR A 2606788423 | XYZ-6745226567 55044 DERI AMIROSCHK... = ARAMORTRINM City MD 62213 |
PER-099 | ATIR AZRIFA'ARN A 2727057846 | XYI-6846643584 07220 BESIRROMA BISG... = BESESTAN City MD 43518
PER-111 ARRDARKIA DURMAVESH D 4073853748 XYZ-6653456318 21117 ANDORAD ARKEB... = CAROMURIO City MD 53355
PER-116 = ARSHMICK CORMAPHIR B 6414777302 | XYZ-6626557177 22310 DEVE DEMAR. Street | DAELELEE City MD 51310
PER-122 | AUDRIANI ARAMORTRIM D 4137473785  XYZ-6341824026 64014 DRIST DAHRAIG ... = AKIN City MD | 30672
PER-123 | ALOISIA AAKKAS D 1401518506 | XYZ-6607438008 72408 ALHAPO DREL Str... | ADRAQCI City MD 13688
PER-137 | CALIDRIM CHINTANN E 5775568682 XYZ-6376362002 60055 BROSCARRUN AM... = AINCIR City MD 51055
PER-142 | DAMINTHOR DASLANHIR A 6853356300 | XYZ-0218658267 15453 ANIOMERIAM AM... | AVER City MD | 08774
PER-157 = ASHELYN ALTIA B 2488321513  XYZ-6186661833 02105 ASHMICK BESTRE... | CEDSTLIMO City MD 652747
PER-173 = ARKIN BRASH D 4156258872  XYZI-6526136621 83250 ALOISIA AAKA 5t... | CRABILTIA City MD 87855
PER-175 DHURMOROTT BESTREVEAMN B 1182811616 | XYZ-6533102030 30711 CEDSTLIMO ALTH... = ADRAQI City MD 56513
PER-189  DERDI BELGAN B 8634563320  XYZ-6105230641 18672 BISPETH BRADI 5... | BERFEL City MD 206560
PER-214 BANTI CONI B 6655673658 | XYZ-6712880554 41252 AZRIFA'ARN ALG... | DANNON City MD 60175
PER-216 = AGUILTHIR ANDORAD B 8755854663 | XYZI-6478448522 32830 CAEM AUDRIANI ... | CADI City MD J0707
PER-220 | AVATTHARL DOLD A 4348857754 | XYZ7-6138143028 72323 DAFLFLEB BRIBO...  AMATH City MD | 67312 |7
Resuits are sorted by relevance to criteria. Sorting by 2 column will cause this order to be lost.
| Logged in as depryf at FAC-000051 (Testing Hospital) | | Showing Search

Which fields is search and how (perfect match, starts with or fuzzy search) depends on your
registry’s configuration. You can review the search criteria for your registry by clicking the
question mark icon above the Rest button:

&) Help - Search [é]

Use the text fields to provide vour search criteria. Different fields will be combined together using the AND operator.

To trigger the search, type Enter or click the Search button.

By default, the results are sorted by relevance to the provided crifenia; that order can be changed by clicking one of
the columns, but the default order will then be lost. The following fields are searched:

¢ Last Name (fuzzy)
¢ First Name (fuzzy)
¢ NPI (contains)

¢ License # (contains)
¢ 1D (contains)

To view one of the results, double-click its row. Use the contextual menu (accessed by clicking on the table of
results with the right button of the mouse) to access more actions related to the table.
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SEER*Rx Drugs and Regimens

The SEER*Rx Drugs and Regimens are available in the Search page. By default no drug is
displayed. Click Search without providing a search term to display all the drugs.

.
B SEER Abstracting Tool

(=] E )

File Show Action Help

Patient Data | Fadilities | Physicians | SEER*Rxt | Hematopoietic and Lymphoid Database |

Search Text: |

| Require all terms

Search Drugs

Search Regimens L2

Results: 2,664

[D] 1, 25-Dihydroxyvitamin D3

[D] 1-Methyl-D-tryptophan
[O] 1018155

[O] 109881

[0] 1311-TM-501

[0] 131-MIBG

[D] 17-DMAG

[O] 2, 4-Dinitrochlorobenzene
[D] 2-alizapride Hydrochloride
[D] 2B1 bispecific murine MAb

[D] 4-Hydroxyphenyl retinamide
[O] 4-Nitroestrone

[O] 5'-Inosinic acid polymers
[R] 5+2 protocol

[D] 5-Aza-2Deoxy-cytiding
[D] 5-fluoro-2-deoxycytidine
[o] 5-FP

[0] 586CE0

[D] 6-Azuridine

[D] 6-Diazo-5-ox0-L-norleucine
[R] 7 + 3 protocal

[R]&in 1

[O] 845 4B5

[D] 9-Aminocamptothedn

[D] 935083

[D] 90Y-hPaM4

[O] A 80987

[D1 A-77003

L —TT—

[D] 4'-Hydroperoxycycophosphamid

»

Drug Information

Generic Name

1,25-Dihydroxyvitamin D3

Brand Name

Calcijex
Calditrol
Di-vit-Sol
Multi-M
Rocatrol
Tolerex
Vivonex T.E.N.

Category

|Dif'ferentiaﬁon inducing agent

Subcategory

|Do not code

Remarks

|Dif'ferentiaﬁon Inducing Agent; Vitamin

| Logged in as depryf at FAC-000051 (Testing Hospital) |

Showing Search

.

To search for a particular drug or regimen:

1. Type one or several words in the Search Text.

2. Type Enter or click the Search button.

3. The results are displayed on the left side of the window; they are sorted by relevance to the
search terms. The first result is selected by default; to view other drugs or regimens, use
the up and down arrows to browse the list of results.

4. The drug or regimen selected in the Results list is shown on the right side of the window.
The search terms found in the fields are displayed in red. The search is based on

a. Which field(s) contained the terms (a term found in the Generic Name will yield a
higher score than one found in the Remarks for example).

b. How many times the term was found in the field(s).
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c. Whether the terms was a perfect match to the field(s), or if the field(s) started with
the term, or if the term was only contained in the field(s).

5. By default, if several terms are provided, they will all be required in search fields (this is an
AND’ed query). To require any term instead (an OR’ed query), uncheck the Required all
terms checkbox. The terms are separated by a space; to search for a term containing a
space, enclose it with double quotes.

6. To limit the search to drugs only, unselect the Search Regimens checkbox.

7. To limit the search to regimens only, unselect the Search Drugs checkbox.

The following screenshot shows a drug found for the term “adreno”.

-
B SEER Abstracting Tool

File 5Show Action Help

Patient Data | Fadilities | Physicians | SEER*Rxt | Hematopoietic and Lymphoid Database |

Search Text: | adreno

| Require all terms Search Drugs

Search Regimens

\‘?/:

Results: 12

[D] Adrenocorticotropic hormone

[D] Corticotropin

[O] Desoxycortico-sterone Acetate
[O] Desoxycorticosterone Pivalate
[D] Cosyntropin

[D] Fludrocortisone Acetate

[D] Trilostane

[O] Aminoglutethimide

[O] D3967

[O] Dexamethasone Acetate

[D] Hydrocortisone

[D] Prednisclone

Drug Information

Data Version: 2012-03-19

|Adrenocorﬁcotropic hormone

Abbreviation

[acTH

Category

|Hormones and hormonal mechanisms

Subcategory

|Glucocorﬁcoid. Probably not cancer directed--verify with attending MD.

NSC Number

| 25033

Remarks

|Chief function is to stimulate the cortex of the adrenal gland to secrete adrenocortical steraids, chief among them cortisone-the stress hormone., |

| Logged in as depryf at FAC-000051 (Testing Hospital) |

| Showing Search

A complex algorithm is used to search the different fields contained in the drugs and regimens. To
view which fields are searched and their corresponding weight, click the question mark button on
top of the Reset button:
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——— —l

.
&) Help - Search e — o ——

This page allows vou to search the SEER*Rx drugs data.
Use the text fields to provide your search criteria.
To trigger the search, type Enter or click the Search button.

The results are sorted by relevance to the provided criteria. The following fields are searched:

* generic name (weight=20)
® brand name (weight=10)
* NSC number: (weight=0)
abbreviation (weight=8)
category (weight=3)
subcategory (weight=3)
remarks (weight=2)
primary site (weight=2)

.« s " 0

The weight is used to calculate the relevance of the searched term and sort the results accordingly. By default, all the
terms provided need to be found in the data (the terms are separated by an AND): uncheck the Require all terms
checkbox to switch to a search where at least one term is required (the terms are separated by an OR); using the
second option might return more results. To search for a term containing a space, enclose it in double-quotes.

Results starting with [D] represent a drug, results starting with [R] represent a regimen.

Select a particular result on the left panel to display the corresonding drug or regimen on the right panel. The search
term will be highlighted in red anywhere it appears.

To restrict your search to drugs only or regimens only, use the Search Drugs and Search Regimens checkboxes.

Regimens are displayed differently than the drugs; since they represent a set of drugs, the
information panel shows which drugs make up the regimen. The following screenshot shows a
regimen found for the term “AC".

-
B SEER Abstracting Tool

[E=EEE )

File  Show Action Help

Patient Data | Fadlities | Physidans | SEER*Rx | Hematopoietic and Lymphoid Database |

Search Text: |ac | Require all terms Search Drugs Search Regimens @
——— ——
[D] Hydrocortisone - =
[D] Quinacrine | me
[D] Triamcinolone Acetonide |Ac |
[ H)f'drnc.nrﬁsnne _’QEE‘B‘E Drug #1: |Cydcphosphamide | code as |Chemcﬂ1erapy |
[D] Triamcinolone Diacetate

| [R] AC Drug #2: |Dcxorubidn | code as |Chemctherapy |
|| |[RIAC Code this regimen in each of the treatment fields shown above.
(|| |[R]AC If two or more drugs are coded as Chemotherapy, use code 03, combination of Chemotherapy.
|| |[R] AC
[D] Acronine Cyclophosphamide | Doxorubicin
[C] Aminosalicylic Acid
' | | (0] Dexamethasone Generic Name -
|| | [D] Accutane |Cydophosphamide
[C] Azacitidine Brand Name
ACFUCY =
[l Asta B 513 3
[R] ACID B-513
[R] AC-T Clafen Claphene
[R] ACE Cydophosphamid | 5
ydophosphan
[R] ACMF Cydophosph,
[R] ACT-FU-Cy Cydophosphane
[D] Calcium Carbonate Cytophosphan
[D] Cortisone Acetate E:;?:;:
[D] Spironolactone Endoxana
[R] Ac-D-Ac Enduxan
(|| | R] Ace Genoxal
[R] ACE Neosar
[R] ACM Procytox
|| |[R] ACOAP ienc‘i:xan
(| i ymtram
l [E)] Awd:rmle . WR-138713 2

|| Logged in as depryf at FAC-000051 (Testing Hospital) |

Showing Search
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Since the information panel can contain a lot of data, it might scroll. Therefore it is sometimes
useful to be able to hide the Results panel and show the information on the full screen. To
accomplish that use the Ctrl+< shortcut to hide the results (to extend the information panel to the
left) and Ctrl+]| to show it again (to come back to a split view). You can always change the amount
of horizontal space that each panel uses by dragging the separation between them to the left or to
the right.

Hematopoietic Disease Database

The Hematopoietic and Lymphoid Diseases are available in the Search page. By default no disease
is displayed. Click Search without providing a search term to display all the disease.

F ™
A SEER Abstracting Tool [E=YEERTC

File 5Show Action Help

Patient Data | Fadilities | Physidans | SEER*Rx | Hematopoietic and Lymphoid Database

Search Text: | | Require all terms =]

Results: 161 View Hematopoietic Manual Data Version: 2012-03-26
e orcase Information

Acute basophilic leukemia - | [ -
:EE :_2::;?5:!:::““5 [0Bs] |Acube basophilic leukemia |
Acute megakaryoblastic leukemia | = || | ICD-0-3 Code Reportability Grade Primary Site(s)

Acute monoblastic and monocytic leu |98?D.|’3 [REPORTABLE] C421 |
Acute myeloblastic leukemia with ma'—| | pefinitions

Acute myeloid leukemia (megakaryot
Acute myeloid leukemia with inv(16)(

Acute myeloid leukemia with inv(3)(q Rare form of Acute myeloid leukemia where blasts are accompanied by abnormal basophils in all stages of differentiation.
Acute myeloid leukemia with minimal

An acute myeloid leukemia in which the primary differentiation is to basophils.

) o Abstractor Notes
Acute myeloid leukemia with myelody - —— - —— — — - A
i Acute myeloid leukemia with £(5;9)( Cutaneous involvement, organomegaly, lytic lesion, and symptoms relating to hyperhistaminemia may be present. Basophilic leukemia is differentiated E
¥ R o i2)P from other AML subtypes with basophilia using basophilia immunological markers, light microscopic cytochemistry for myeloperoxidase and electron
Acute myeloid leukemia with t{9; 11)( microscopy.

Acute myeloid leukemia without mat. — - -
Acute myeloid leukemia, NOS Definitive Diagnostic Methods
Acute myeloid leukemia, t(8;21)(q22 Bone marrow

Acute myelomenocytic leukemia Ipni;:ﬂjnirlzlsglaﬁimish'y

Acute panmyelosis with myelofibrosis

Acute promyelocytic leukemia (AML v Genetics

Acute undifferentiated leukemia |N0 consistent chromosome abnormality
Adult T-cell leukemia lymphoma 1 typing i
Adult T-cell leukemialymphoma (HTL CD1ib+
Aggressive NK-cell leukemia D13+
ALK-positive large B-cell lymphoma D22+ (possible)
1 Anaplastic large cell lymphoma, ALK- CD33+
Angiocentric immunoproliferative lesi D34 (possible expression)
Angicimmunoblastic lymphadenopath CD117-
Angioimmunoblastic T-cell lymphoma Eg;ég;_
Atypical chronic myeloid leukemia, BC ™ HLA-DR + (possible)
«[.m | 3 i) o -
| Logged in as depryf at FAC-000051 (Testing Hospital) | Showing Search

To search for a particular disease:
1. Type one or several words in the Search Text.
2. Type Enter or click the Search button.

3. The results are displayed on the left side of the window; they are sorted by relevance to the
search terms. The first result is selected by default; to view other diseases, use the up and
down arrows to browse the list of results.
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4. The disease selected in the Results list is shown on the right side of the window. The search
terms found in the fields are displayed in red. The search is based on

a. Which fields contained the terms (a term found in the Generic Name will yield a
higher score than one found in the Remarks).

b. How many times the term was found in the fields.

c. Whether the terms was a perfect match to the field, or if the field started with the
term, or if the term was only contained in the field.

5. By default, if several terms are provided, they will all be required in search fields (this is an
AND’ed query). To require any term instead (an OR’ed query), uncheck the Required all
terms checkbox. The terms are separated by a space; to search for a term containing a
space, enclose it with double quotes.

The following screenshot shows a drug found for the terms “leukemia” and “chronic”.

F B
EA SEER Abstracting Tool [E=SER

File  Show Action Help

Patient Data | Fadilities | Physicians | SEER*Rx | H topoietic and Ly

Search Text: |1eukemia chronie | Require all terms @

Results: 14 Wiew Hematopoietic Manual Data Version: 2012-03-26
Disease Information

-
Name

Chronic myelogenous leukemia, BCRJABI
Chronic myeloid leukemia, NOS
Chronic lymphocytic leukemia zmall lymp!
Chronic myelomonocytic leukemia ICD-0-3 Code Reportability Grade Primary Site(s)

Chronic eosinophilic leukemia, MOS |98?5.|’3 [REPORTAEBLE] c421 |
Chronic neutrophilic leukemia
Atypical chronic myeloid leukemia, BCR-
Adult T-cell leukemia lymphoma

|Chron'|c myelogenous leukemia, BCR/ABL1 positive |

Alternate Names

Chronic granulocytic leukemia

Chronic granulocytic leukemia, BCR/ABL

Leukemia, NOS Chronic granulocytic leukemia, Philadelphia chromosome, (Ph1) positive

Myeloid and lymphoid neoplasms with FE | | Chronic granulocytic leukemia, t(9;22)(g34;q11)

Myeloid and lymphoid neoplasms with PO | |Chronic myelogenous leukemia (Philadelphia chromosome, t(9;22)(q34;911), BCR/ABL positive)
Myeloid leukemia, NOS Chronic myelogenous leukemia, Philadelphia chromosome, (Ph1) positive

Myeloid neoplasms with PDGFRE rearrar] Chronic myelogenous leukemia, (3;22)(334q11)

Juvenile myel tic leukermi by
Uvenile myelomonocytc IEUKEmMIa CML—ACCE'EI’EtEd DhESE

CML-Blast Phase B
CML-Chronic Phase

Definitions
Myeloproliferative neoplasm that is consistently associated with the BCR-ABL 1 fusion gene located in the Philadelphia chromosome; originates in an

abnormal bone marrow stem cell.
CML has three phases: chronic, accelerated, and the blastic phase or blast crisis.

Abstractor Notes

85% of patients are diagnosed in the chronic, asymptomatic phase. The diagnoses is usually inddental when the patient has a CBC and,or peripheral
blood smear. If the results of the WEBC are abnormal (elevated) the physician will order a bone marrow aspiration. The bone marrow is examined by

[ chromosome and,for molecular techniques for the Philadelphia chromosome. Confirming the presence of the Philadelphia chromosome is required for a
definitive diagnosis of CML. The Philadelphia chromosome is identified in the bone marrow by FISH analysis. The Polymerase chain reaction (PCR)is a
wery spedialized molecular blood test that can detect the BCR-ABL1 gene from a blood sample or bone marrow. CML has three phases: chronic,
accelerated, and the blastic phase or blast crisis, The accelerated phase can last weeks to months. In the chronic phase the involvement is usually
limited to blood, bone marrow and spleen, although the liver may be infiltrated. During the blastic phase, lymph nodes and tissue may be involved. The
blastic phase is a disease progression from the chronic phase, The disease; however, remains the same histology: Chronic myelogenous leukemia, The
4 1 | 3 terminal phase is the last phase and survival is usually only weeks or months, -

m

| Logged in as depryf at FAC-000051 (Testing Hospital) | | Showing Search

A complex algorithm is used to search the different fields contained in the drugs and regimens. To
view which fields are searched and their corresponding weight, click the question mark button on
top of the Reset button:
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& Help - Search ﬁ

This page allows vou to search the Hematopoietic and Lymphotd Database for diseases.
Use the text fields to provide vour search criteria.
To trigger the search, type Enter or click the Search button.

The results are sorted by relevance to the provided criteria. The following fields are searched:

* name (weight=100)
* code (weight=100)
* alternate name (weight=10)

The weight is used to calculate the relevance of the searched term and sort the results accordingly. By default, all the
terms provided need to be found in the data (the terms are separated by an AND); uncheck the Require all terms
checkbox to switch to a search where at least one term is required (the terms are separated by an OR); using the
sacond option might return more results. To search for a term containing a space, enclose it in double-quotes.

Select a particular result on the left panel to display the corresonding disease on the right panel. The search term will
be highlighted in red anywhere it appears.

Since the information panel can contain a lot of data, it might scroll. Therefore it is sometimes
useful to be able to hide the Results panel and show the information on the full screen. To
accomplish that use the Ctrl+< shortcut to hide the results (to extend the information panel to the
left) and Ctrl+| to show it again (to come back to a split view). You can always change the amount
of horizontal space that each panel uses by dragging the separation between them to the left or to

the right.
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Section 6: Synchronizing SEER*Abs with the Central Registry

The Synchronization module allows you to update your copy of SEER*Abs with data from the
registry’s main database; and it allows you to create extracts that can be used to submit your data
to the registry. Data imported into SEER*Abs include AFLs requiring attention and reference data.
The reference data includes lookup tables, facility and contact lists, consolidated patient data, and
unconsolidated patient records.

The type of the reference data and how it is imported is configured differently in each Registry.
The following screenshot shows the default application in which the reference data can be imported
from files or from a connection to the Central Registry’s database.

EA SEER Abstracting Tool | B i)

File Show Action Help

'y
Export Data Import Data
Following data are ready to be exported:
Abstract Records: 1 [ Import Data Files ] %]
Abstract Facility Leads: 0
[ Download from Central Registry ] [+
; 2 [ View Import History ] L2
| Create Data Files | %]
[ Recover Data File ] %]
[ View Export History ] -
| Logged in as depryf | Showing Synchronization
b
Exporting Data

Updated AFLs and completed records can be exported from SEER*Abs into external files for
submission to the central registry or through a straight database update (the second method is not
enabled in the default configuration provided with the application).
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To export record and/or AFLs:

1. Go to the Synchronization page (press F4; click the Synchronization toolbar icon; or select
Show -> Synchronization).

2. In the Export Data section, click the Create Data Files button. The following dialog will
be displayed:

B synchronization Options - SEER*Abs - &]

Select the type(s) you would like to extract; you can modify the target file name and the target folder by using the Browse button
or by editing the text box.

[ Select Al ] [ Clear Al ]
Abstract Records (1) E:'seerabs\test\outputiabs_20110804_085750_001.ted
Abstract Fadlity Leads (0) T

A

3. Check the data types you wish to export.

a. The number of records/AFLs that can be extracted is shown in parenthesis after the
data type label; if a particular type has no entity that can be extracted, it will be
disabled.

b. The system generates a unique file name for the extract. You can modify the file
name by editing it in the text box, or you can use the browse button to select a
different location.

c. Itis recommended that you extract Abstracts whenever you extract AFLs and vice
versa.

4. Click OK. SEER*Abs will execute each script and indicate whether the script executed
successfully or if errors were encountered.

o S ———
[ Task Progress - SEER*Abs 5

Running synchronization script for Abstract Records
> Done writing abs_20110804_085750_001.txd, extracted 1 records
> Done updating record statuses to 'ARCHIVED'

Successfully ran script

Done executing requested scripti(s) in < 1 second

k

5. Click Close.

Once the process is done, the extracted records/AFL will be flagged as ARCHIVED. Archived
entities are read-only and cannot be modified anymore.

To view the history of the exports, click the View Export History button. A dialog will be
displayed with a table containing one row for each extracted data type. Click on one of the
columns to sort the rows according to the data contained in the column.
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g Synchronization History - SEER*Abs LE-J

Username Date Data Type Method Information
depryf

03/04/20119:01 AM | AbstractRecord | Extract = E:\seerabs\test\output\abs_20110804_085750_001.txd

Importing Data

Data can be imported into SEER*Abs directly from a database or can be imported from external
files. The IT staff responsible for configuration the application should tell you which method will be
used in your registry. If importing files is enabled, an Import Data File button will be shown on
the synchronization page; if downloading data from the Central Registry’s database is enabled, a
Download from Central Registry button will be shown. If external files will be used, please be
sure you understand when new files will be created for your use.

There are several types of data that can be imported.

1.

Lookup - The codes and corresponding meanings for the various fields in SEER*Abs. This
must be imported before you can begin using SEER*Abs.

Facility — The facilities (hospitals, labs, etc) associated with your registry. This must be
imported before you can begin using SEER*Abs. This allows you to indicate where you are
collecting data when you log in, as well as capture where events occurred in the records you
are creating.

Physicians — The physicians associated with your registry. This should be imported before
you begin using SEER*Abs. This allows you to capture which doctors interacted with the
patients in the records you are creating.

AFL - Abstract Facility Leads (AFLs) represent the tasks within SEER*Abs. An AFL should
contain enough information about the patient (e.g. Name, SSN, DOB, etc), the cancer (e.g.
Site, Laterality, Date, etc) and facility (Facility ID) to enable you to create the desired
abstracts. This should be imported before you begin using SEER*Abs.

Reference Data — Data already captured in the central registry. This would allow you to
review what is already known about the patient and cancer before you create a new record.
Not all registries will choose to have this information available to their abstractors. If your
registry does provide this information, then the reference data should be imported before
you begin using SEER*Abs. Reference data can include the following (as originally shipped),
but the exact types would be controlled by the configurations set by your registry staff.

a. Patient - the consolidated information for a patient, all their related tumors and
whatever admission and treatment information your registry chooses to provide.

b. Record (NAACCR) -Abstracts in NAACCR format that has arrived at the central
registry but has not yet been processed; data that is unlinked and unconsolidated.

c. Again, the exact components of the reference data, or even if it is available at all,
are controlled by your registry.
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You should import data into SEER*Abs before you start to use SEER*Abs in the field. Since the

information in the central registry is constantly being updated, this import should be done
regularly.

To import data into SEER*Abs:

1. Go to the Synchronization page (press F4; click the Synchronization toolbar icon; or select
Show -> Synchronization).

2. In the Import Reference Data section, click the button corresponding to the
synchronization method you wish to use:

a. Download from Central Registry: a dialog will be displayed; select the data types
you wish to download.

F |
nchronization Options - 5
Synchronization Options - SEER"Abs (BRES

Select the type(s) you would like to download.

| selectal |[ Clearal

Lookups

Facilities

Physicians

Ahstract Fadility Leads
Patient Sets

MAACCR Records

’ OK ] [ Cancel f

LS

b. Import Data Files: a dialog will be displayed; select the data types you wish to
download and provide the location of each data file.

B Synchronization Opticns - SEER*Abs @

i . —

Select the type(s) you would like to import; you have to provide a source file for any type that is selected.

| selectl || Clear Al

[] Loockups Browse...
[[] Fadiities Browse...

[] Physidans Browse...

[] Abstract Facility Leads Browse...

[] Patient Sets Browse...

[] NAACCR Records Browse...

[ OK ] [ cancel
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3. Click OK.

4. If you have selected the method Download from Central Registry, will be presented with
a Remote Login screen. The information about the databases you can connect to will be
based on configurations set by your registry staff. They should provide you with the
information below.

a. Select the database you wish to Connect To.

b. Enter the username for that database (there might be a default username provided).
c. Enter the password for that database.

d. Click Login.

5. The Synchronization Progress dialog will appear. The download takes time to complete, the
exact length of which will vary by how much data you are importing.

Task Progress - SEER™A

¥ =

. . e -
> deleting prewious facilities...

> deleted previous facilities in 0.058s
> persisted last 233, persisted 232 facilities in 0.53s
Successfully ran script

Bunning synchronization script for Physicians
> deleting prewious physicians. ..
> deleted previous physicians in 0.038s
> persisted another 5000 in 3.72s3, persisted 5000 so far
> persisted last 2353, persisted 7353 physicians in 5.138s

Successfully ran script

Bunning synchronization script for Abstract Facility Leads
> deleting prewious "NOT PROCESSED' AFLs. ..
> deleted 0 'NOT EROCESSED' AFLs im 0.0Zs
> persisted last 33, persisted 53 AFLs in 0.318s

Successfully ran script

Bunning synchronization script for Patient Sets
> deleting prewvious patients...
> deleted previous patients in 0.1Z1s
> persisted last 1, persisted 1 patients in 0.157s

Successfully ran script

PBunning synchronization script for NAACCR Records
> deleting prewvious NARCCE records...
> deleted previous NARCCR records in 0.04s
> persisted last 1383, persisted 1383 NARCCRE records in 5.445s

Successfully ran script

m

Done executing regquested script(s) im 12 seconds -

6. Click Close.
Once the process is done, the imported data will be available in the application.

To view the history of the imports, click the View Import History button. A dialog will be
displayed with a table containing one row for each data type imported. Click on one of the columns
to sort the rows according to the data contained in the column.
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.
g Synchronization History - SEER*Abs

Username D.iite Data Type
depryf 03/04/2011 10:06 AM Physician
depryf 08/04/2011 10:06 AM Patient Set
depryf 03/04/2011 10:06 AM | MAACCR Record
depryf | 08/04/2011 10:06 AM AFL
depryf 03/04/2011 10:05 AM Lookup
depryf 08/04/2011 10:05 AM Fadility

Method
Import
Import
Import
Import
Import
Import

Information
E:\projects\seerabs\test\com\jmsweb\seerabs\testing\data\physician. tet
E:'\projects\seerabs!test\comljmsweb\seerabstesting\data\patient. txt
E:'\projects\seerabs!test\comljmsweb\seerabs\testing\data\naacer. txt
E:\projects\seerabs\test\com\jmsweb\seerabs\testing\data'\afl. bt
E:'\projects\seerabs!test\comljmsweb'\seerabstesting\datalookup. txt
E:'\projects\seerabs!test\comlimsweb\seerabs\testing\data\fadility. txt

Recovering an extracted data file

SEER*Abs keeps the last 10 extract files for each data type in its database and allow them to be

re-created in case they were not been successfully transmitted to the registry.

To recover an extract:

1.

Go to the Synchronization page (press F4; click the Synchronization toolbar icon; or select
Show -> Synchronization).

2. Click the Recover Data File button.

g Extract Recovery - SEER*Abs

The following table shows the extracts that can be recovered {only the last 10 exracts are available for each data type).
To recover a particular extract, double-dick the corresponding row.

Username Date

Data Type File

depryf 08/04/2011 9:01 AM | Abstract Records | E:\seerabs\testloutput\abs_20110804 _085750_001. td

Double click on the row of the extract that needs to be re-created.

Click the Yes button of the confirmation dialog.

Click OK and Close.

The file is re-created in the output folder. To open that folder and verify that the file is

there, select Show -> Output Folder.
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